
Setting ruler format

You can specify the time and level (amplitude) formats for each ruler in each window:

1. Press the right mouse button over the ruler, to bring up the speed menu for that ruler.

2.Select a format from the available options.
For details about each format, select it from the menu, and with the menu still up, press [F1].

3.If you have specified Time code or Meter as your time format, open the Preferences dialog, click on the 
Tempo/Time code tab and specify details for the format.
See the dialog's context sensitive help for details.
            Related Topics  



Setting a ruler start position 

Normally, the ruler is set so that the beginning of the file represents position "0". However, for editing purposes you
may want to set the "0" position to some other point in the file.

1. Click in the ruler at the position where you want position "0" to be.

2. Click with the right mouse button in the time ruler and select "Set origin at cursor" from the menu that appears.
The ruler start point is moved to the cursor position.
            Related Topics  



Setting a format for dialogs

You can specify how units of time and level should be displayed in dialog boxes:

1.Select Preferences from the Options menu.

2.Click on the Units tab.

3.Use the radio buttons to select an option.
For details about the formats, use the context sensitive help. The "As active window" option means that the 
formats in dialogs and on the status bar follows the unit setting of the ruler in the active window.

4.If you have specified Time code or Meter as your time format, click on the Tempo/Time code tab and specify 
details for the format.
Again, see the context sensitive help for details.



Changing Preferences that affect "looks"
The Preferences dialog contains various options that affect the "looks" of the program.

1.Select Preferences from the Options menu.

2.Click on the desired    tab and change the settings:
The Toolbar/Status Bar contains settings for all Toolbars and the Status Bar.
The Display tab is used for various settings that affect Wave window's appearance.
The Units and Tempo/Time code tabs contain various settings for time and level formats.

For details about the options in each tab, use the context sensitive help in the dialog.
Setting a format for dialogs



Styling wave displays 

For each channel in each wave display you can make settings that affect the following:

Waveform Elements
To select which elements should be visible, and their appearance, proceed as follows:

1.Press the right mouse button with the pointer somewhere in a certain channel in the main view or overview.

2.From the menu that appears, select Elements and then select the desired item from the sub-menu that appears.
For details about each item, select it from the menu, and with the menu still up, press [F1].

Color

You can also set the color of various items (background, waveform etc). See Changing Color.

Ruler Style
You can change the look of rulers, see Styling rulers.

Applying Styles
All of the above can be defined as a Style, see Saving Styles.

To select a style for the current window, proceed as follows:

1.Pull down the Options menu.

2.Select Style, and from the sub-menu that appears, select the desired Style.
The Style setting is not saved with the file.
            Related Topics  



Styling rulers 

To change the look of the rulers, proceed as follows:

1.Click on the ruler with the right mouse button.

2.From the menu that appears, select Style.

3.Select an option.
For details about each item, select it from the menu, and with the menu still up, press [F1].
            Related Topics  



Changing Colors

To set the color of a certain element in the display, proceed as follows:

1.Click the right mouse button in the waveform display.
Please note that for all elements it matters whether you click in the overview or in the main wave display and in 
which channel. If you for example want to change the color of the waveform in the left channel in the main view, 
click there.

2.Select Color, and then select an element from the sub-menu that appears.
The standard Windows color dialog appears.

Please note that the Wave cursor is shown in inverse video to speed up screen redraw! Hence it will be 
shown in the "opposite" color compared to what you select.
3. Select or define a color and click OK.

            Related Topics  



Saving Styles 

If you have made settings for Waveform elements, Colors and Ruler Style as described    on the cards describing 
Waveform Elements, Styling rulers and Changing Color you have essentially created a Style. You can save and recall
six styles.

To create your own style, proceed as follows:

1.Set up the window as you want it, with regards to colors, rulers etc.

2.Pull down the Options menu.

3.Select Style and from the sub-menu that appears, select Save.

4.In the dialog that appears, click one of the radio buttons and type in a name.

5.Click OK.
The Styles are saved globally, that is all windows have access to the same six styles.

            Related Topics  



The Default Style 

The top item on the Style menu and in the Style Save dialog is called Default. This is the Style that will be used 
when you first open a window or create a new one by selecting New.

            Related Topics  



Using the Zoom controls 

Both the main view and the overview have horizontal and vertical zoom controls located next to the scroll bars. 
These are operated just like scroll bars:

You can drag the handle to any position.
You can click anywhere on the scale to move the handle there.
You can click on the arrows at either end to change the zoom factor in smaller steps.

Either way, the zoom factor on the Status Bar is updated continuously.
               Related Topics  



Using the Magnifying glass in the main view 

The Magnifying glass tool is used to specify any section of the waveform and have it occupy the entire window.

Selecting the Tool

The Magnifying Glass Tool can of course be selected from the Tool box, but there are two other options:
When you hold down [Control] and move the pointer over the main view, the magnifying glass is 

automatically selected.
This is just a momentary selection, as soon as you release [Control] you get the previous tool back.

When you move the pointer over the overview, it turns into the Magnifying Glass automatically.

Using the Tool

1.Press the mouse with the pointer somewhere in the waveform.

2.Drag left or right to make up a box, and then release the mouse.
The area encompassed in the box now fills up the entire window.

               Related Topics  



Using the magnifying glass in the overview 

The Magnifying Glass is used in the overview, just as in the main view, see Using the Magnifying glass in the main 
view. However, even though you use the tool in the overview, it is the main view that gets zoomed.

You can for example use this as follows: Keep the overview zoomed out all the way and use the magnifying tool to 
display any section in the main view.
               Related Topics  



Using Zoom selection 

If you have made a selection, you can automatically zoom the window so that the selection fills the entire display.

1.Make a selection.

2.Click the right mouse button in the main view or the overview.

3.From the menu that appears, select "Zoom selection".
Alternatively, you can press [K].

               Related Topics  



Zooming    via the keyboard 

A number of short-cuts are available for zooming, see Keyboard Commands - Zooming.
               Related Topics  



Using "Auto Zoom for overview" 

This setting, found in the editing section of the Preferences dialog, allows you to have the zoom factor automatically
adjusted, so that it always shows the entire wave. This is mainly intended for the overview pane (hence the name) 
but can be applied to the main view too. Below we assume you will use it for the overview.

1.Activate "Auto zoom for overview" in the Preferences dialog.

2.Zoom out on the overview so that you see the entire wave.

Now, when you resize the window, the overview zoom factor is automatically adjusted so that the entire wave is 
always shown. If you later zoom in on the overview, the automatic zooming is deactivated until you zoom out all the
way again.
               Related Topics  



Navigating using the range indicator 

In the overview, a striped line called the "range indicator" tells you which section of the file that is currently 
displayed in the main view.

Furthermore, the range indicator moves while you drag the scroll bar handle. This means that by observing the 
overview you can easily find positions in the main view when scrolling, even though the main view might be 
zoomed in very far.

The range indicator can be displayed at the top or bottom of the overview, by pressing the right mouse button in 
the overview, selecting Elements and then selecting "Range indicator at top/bottom". 
               Related Topics  



Navigating using the Goto menu 

There are two ways to bring up the Goto menu:
Select Goto from the main View menu, or...
Click with the right mouse button in the overview or in the main view.

The difference between the two methods is that the main menu always affects the main view, while the speed 
menus affect either view depending on where you clicked.

For details about each item, select it from the menu, and with the menu still up, press [F1].
            Related Topics  



Navigating using the Transport 

The transport is used for moving the wave cursor. If "Scroll during playback" on the Options menu is activated, 
using the Transport also scrolls the display.

Displaying the Transport

If the Transport is hidden, select Transport from the Windows menu.

The Transport controls

To find out what the Transport buttons do, simply move the mouse pointer over a button and wait for a pop-up to 
appear.
If this doesn't seem to work, make sure Show Tips is activated in the Preferences dialog.

The Stop button

The Stop button has a special function related to the selection:
If the program is stopped and you click the Stop button, the wave cursor is moved to the beginning of the 

selection.
If there is no selection, or if the wave cursor is already to the left of the selection, it is instead move to the 

beginning of the file.
            Related Topics  



Navigating using the keyboard

A number of short-cuts are available for navigating, see Keyboard Commands - Navigating.
            Related Topics  



Navigating using "Move cursor to"

This menu is found on the View menu. The options on this are similar to the Goto menu, see Navigating using the 
Goto menu.

For details about each item, select it from the menu, and with the menu still up, press [F1].

There’s one additional option called "Position" which allows you to specify any position, in the format selected for 
dialogs (see the context sensitive help for details about the items in the dialog).

            Related Topics  



Moving the cursor to a Marker 

To move the wave cursor to a certain marker, do one of the three following:
Double click on the marker triangle.

This is probably the most convenient option if the Marker is currently visible in the window. This even works 
during playback!

Double click in the ruler, select one of the markers in the list that appears, and click Close.
This is probably the most convenient option if the Marker is outside the current view.

Activate "Magnetize bounds" on the Options menu. Click on the ruler, close to the Marker or drag the 
cursor to a position close to the Marker.
               Related Topics  



Playing - Using the Transport 
To play a section of audio, using the Transport, proceed as follows:

1.Position the wave cursor from where you want playback to start.
This can for example be done by clicking in the waveform with the Select tool.

2.Click the Play button.

3.To stop playback, click the Stop button.
If the wave reaches the end, it stops automatically.

               Related Topics  



Using the Play Tool
The Play tool allows you to play from any point by clicking there. It is also the only option that let's you play only 
one channel in a stereo file.

Selecting the Play tool momentarily

The Play tool can of course be selected by clicking in the Toolbox, but there are situations when you are working 
with another tool and just momentarily want to use the Play tool.

To momentarily select the Play tool, hold down [space bar]. When you are done playing, release [space 
bar].

Using the Play tool

The play Tool allows you to play back from any position:

1.Point at the position where you want playback to start.

2.If the wave is in stereo, move the pointer up or down to decide whether only either channel should be played 
back.
Watch the cursor shape, it indicates what will be played back (L, R or both).

3.Press the mouse button.
Playback continues for as long as the mouse button is down, or until the wave ends.

               Related Topics  



Playing - Using the Keyboard 

A number of short-cuts are available for navigating, see Keyboard Commands - Navigating.
               Related Topics  



Playing the selection 

There are four ways to play the selected part of the wave only:
Press the right mouse button in the overview or the main view and select Play Selection from the menu 

that appears.
Drag and drop the selection on the Play button on the Transport.
Hold down [Control] and click on the Play button.
Press [F6].

               Related Topics  



Playing only one channel or both 
If you need to play only one channel in a stereo file, use the Play Tool.
               Related Topics  



Looped Playback 

By activating the Loop button, you can loop any part of the wave:
If some piece of the wave is selected, this will be repeated indefinitely (as long as you don’t start playback 

from a position later than the selection).
The loop points are updated continuously during playback, which means that if you change the selection start or 
end during playback, the new selection is looped instead. This is a great feature for auditioning selection points 
for rhythmic material! Please note that it takes some time for the positions to get updated (1/2 to 3 seconds, 
depending on the file’s bit resolution and sample rate). To "force" an update of the loop points, press [F5].
For those of you that are technically interested, the reason for this delay is that the "playback buffers" have to be 
emptied before the playback "points" can be changed.

If no selection is made, the entire wave is looped.
               Related Topics  



Setting Playback level 

1.Click on the speaker button on the Control bar.

2.Set the volume using the slider that appears.
This sets the overall level of audio playback from the card. The previous level is restored when you quit WaveLab.

3.Click outside the slider.
               Related Topics  



Playing - with 8-bit resolution 

If you need to, you can play back with 8-bit resolution, even though you have a 16-bit card. This could for example 
be used to test what a wave will sound like when played back on an 8-bit card.

To do this, activate Play as 8-bit from the Options menu.

Don’t forget to turn this option off when you don’t need it any more!

Please note that this is a quick "on the fly" conversion from 16 to 8 bit. It is possible to achieve much better quality 
in your 8 bit audio files by using the Dynamic process to compress the audio and then Save Convert the files to 8 
bit.
               Related Topics  



Basic Recording Procedures 

Preparations

To record a new file, proceed as follows:

1.Click the Record button, or press [*] on the numeric key pad.

2.Click the Edit button, and decide for a recording format:
See the context sensitive help for details.

If you choose a format not supported by your audio card, you will not be able to record!

3.If needed, click the Mixer button to adjust the relative volume of your card’s inputs.
See the card Using the mixer.

4.If you want to check the recording level visually, activate "Meters", play back the source to be recorded and 
adjust the level as desired.
See the card Checking Levels.

5.Check the Disk Capacity indicator at the bottom of the dialog to make sure you have enough disk space for the 
recording.
Please note that this is an approximate value.

Start Recording!

1.When all the preparations are done, click Record to start the actual recording.
The recorded time indicator shows you how much you have recorded.

2.When you are done, click Stop.
The recording appears in a new window behind the dialog.

3.Play back the recording by clicking the Play button, to check for distortion or other degradations in audio quality.
When you click Play, the meters are automatically turned off.

4.If you want to perform more recordings after the first, simply click the Record button and record again.

5.When you are done, click Close to close the dialog.
               Related Topics  



Recording - Checking Levels 
If you want to check the recording level visually in the Record dialog, activate "Meters", play back the 

source to be recorded and adjust the level (in the Mixer or externally) as desired.
You have two tools for determining the record level:

The Meters show the current recording level. These meters are very precise. Avoid "hitting the red" except 
for the absolutely loudest signals. If the bar extends all the way up to the "0" indication, chances are the recording 
will be distorted. Lower the level. On the other hand, if the signal never moves up into the "yellow" area, there will 
most likely be too much noise in the recording. Raise the level.

The Peak text indicators show the strongest signal that has passed through the card since you opened the 
dialog or clicked the Reset button. This indication should not reach the "0.0" level. If it does, lower the level, click 
Reset and try again.
               Related Topics  



Recording -Using the mixer 

For the mixer to appear, you must have specifically selected the card in the General section of the Preferences 
dialog. If the Input and Output are set to "Microsoft sound Mapper" a mixer can not be created.

Even if you have selected the card, this operation is not foolproof, since it relies on communication between 
WaveLab and the card’s driver. If the driver does not reply correctly to WaveLab’s inquiries (to be explicit – if the 
driver contains "bugs" – which we unfortunately have noted that some drivers do), a mixer can not be created. The 
program will then alert you. If this is the case, please instead use the application included with the card to access 
the settings.

Exactly what controls will appear in mixer depends on the card, but here are some possibilities:
Master Gain (output - stereo faders)
Synth In (input - stereo faders plus on/off check box)
CD (input - stereo faders plus on/off check box)
Line (input - stereo faders plus on/off check box)
Mic (input - mono faders plus on/off check box)

Stereo controls are normally "ganged" (if you adjust one, they both move) but you can adjust them separately by 
holding down [Control].

In addition to the above, the card might have custom controls for monitoring etc, which can not be accessed from 
the WaveLab mixer. Again, please use the application(s) included with the card.
               Related Topics  



Selecting - at zero crossings 

If you cut out a portion of a wave and paste it in somewhere else, chances are there will be a discontinuity where 
the two waves are joined. This discontinuity will result in a transient in the wave when it is played back, which is 
perceived as a "click" or "bump" in the sound. To avoid this you need to make the splice at a zero crossing. See the 
printed documentation for more background information.

WaveLab can automatically search for zero crossings, and extend the selection "outwards" (make it bigger at both 
ends) so that it begins and ends at a zero crossing. 

1.Pull down the Options menu and activate "Snap to zero crossing".

2.Select Preferences from the Options menu.

3.Click on the Editing tab.

4.Fill out the Snap to Zero crossing options
See the context sensitive help for details about the dialog.

               Related Topics  



Selecting - by dragging 

1.Position the mouse pointer where you want the selection start or end.

2.If the wave is in stereo, move the mouse up and down and check the pointer shape, it will show you whether you 
will select in the left channel, right channel or both channels.

3.Press the mouse button and drag left or right.
If you drag all the way to the left or right side of the window, it scrolls automatically. The speed of the scroll 
depends on how far from the window edge you are.

4.Release the mouse button.
               Related Topics  



Selecting - using [Shift]    

1.Click once somewhere in the wave to set the wave cursor.
If the wave is in stereo, and you wish to select in only one channel, click in the upper part (left channel) or lower 
part (right channel) of that channel.

2.If needed, scroll the view, then hold down [Shift] and click somewhere else.
If you wish to select in only one channel, you must click in the same channel again.
The area between the two points gets selected.



Shifting the selection between channels 

If you have made a selection you can press [Tab] to toggle between having the same selection in either channel or 
both.
               Related Topics  



Selecting the entire wave 

There are several ways to do this:
Double click somewhere in the waveform.

This only works if you don’t have any markers in the wave. 
If you have markers, (or if you’re not sure), hold down [Alt] and double click somewhere in the waveform.

The entire wave gets selected, regardless of markers.
Use Select All on the Select sub-menu on the Edit menu.
Press [Control]-[A].

               Related Topics  



Selecting - between markers 
To select all audio between two adjacent markers, double click between them.
To select all audio between any two markers, double click just to the right of the leftmost one, hold down 

[Shift] and double click just to the left of the rightmost one. 
               Related Topics  



Selecting - using menus and keyboard 

Select to beginning/end

To select from the current wave cursor to the beginning or end of the waveform, use the Select sub-menu on the 
Edit menu, or the keyboard short-cuts (as indicated on the menu).

For info on keyboard commands, see Adjusting selection - using the Keyboard.
               Related Topics  



Adjusting selection - by dragging 

1.Move the mouse pointer to the beginning or end of the selection.
It turns into a double arrow.

2.Press the mouse button and drag left/right.
               Related Topics  



Adjusting selection - by using [Shift]
Hold down [Shift] and click outside (extend) or inside (shrink) the current selection.

If you click inside the first half of the selection, this will change the start point, if you click inside the later half, 
this will change the end point.

               Related Topics  



Adjusting selection - using the Keyboard 

If you hold down [Shift] and press the left and right arrow keys, the end of the selection is moved one pixel (screen 
dot) to the left/right. If you also hold down [Control] it is instead moved twenty pixels. 

Which end of the selection you adjust is determined by which end of the selection the cursor is closest to.

Exactly how much one pixel represents depends on the zoom factor. If the zoom factor for example is "x1:64", the 
cursor keys alone move 64 samples, and together with [Control] they move 1280 samples.
               Related Topics  



Level Selections - using the mouse 

For some of WaveLab’s level processing functions, it is useful to make a selection not only in time, but in level.

The method below might require the [Shift] key to be pressed. This depends on whether the option "Level Selection 
requires [Shift]" is activated or not in the Editing part of the Preferences dialog.

1.Make a regular "time" selection.

2.If required, hold down [Shift].

3.Move the mouse to the top or bottom of the selection box.
The pointer changes into a vertical double arrow.

4.Press the mouse button and drag up/down.
The current level selection is shown on the status bar.

If you later extend the selection time-wise, the level selection still remains the same.
               Related Topics  



Level Selections - using extend to peaks 

To automatically set the level selection to the highest peak in the current selection, proceed as follows.

1.Make a time selection.

2.Select "Extend to peaks" from the Select sub-menu on the Edit menu.
               Related Topics  



Wave Editing - Drag-copying 

The following operation allows you to make a copy of a section of audio, within the same file or from one file to 
another.

1.Make a selection.

2.Point at the selection, press the mouse button and hold it down.

3.Drag to a position outside the selection (in the same file) or drag onto another wave window.
When you have the cursor over a valid area, the pointer will turn into a single or double waveform. The status bar 
will show the exact position the selection will be inserted at.

4.Release the mouse button.
The selection is inserted at the indicated point. The audio that previously began at that point is moved forward so 
that is now played after the inserted section.

Make sure you don’t drop on a selection in the destination window, or you will perform a crossfade.
If the selection is in stereo and you drop on a single channel or vice versa, the program will try to make the

most sensible out of the situation. See the printed documentation for details.
If the you drag between two files and they have different sample rates, the program will warn you that the 

edited section will not play back at the correct pitch. See Resolving Sample Rate Conflicts.
               Related Topics  



Wave Editing - Drag-moving 

The following operation allows you to move a section of audio within the same file or from one file to another.

1.Make a selection.

2.Point at the selection, press the mouse button and hold it down.

3.Hold down [Alt] or [Shift] and drag to a position outside the selection (in the same file) or drag onto another wave 
window.
When you have the cursor over a valid area, the pointer will turn into a single or double waveform. The status bar 
will show the exact position the selection will be inserted at.

4.Release the mouse button.
The material you dragged is removed from its original position and inserted where you drop it.

To completely undo a move between two files you must first undo the Paste in the destination window and 
then Undo the Cut in the source window.

Make sure you don’t drop on a selection in the destination window, or you will perform a crossfade.
If the selection is in stereo and you drop on a single channel or vice versa, the program will try to make the

most sensible out of the situation. See the printed documentation for details.
If the you drag between two files and they have different sample rates, the program will warn you that the 

edited section will not play back at the correct pitch. See Resolving Sample Rate Conflicts.
               Related Topics  



Wave Editing - Dropping on markers 

For any operation involving drag and drop of audio material you can use a marker position as start point for the 
section you drop. This is useful when it is important that the dropped material is inserted at a very specific position.

1.Make sure Magnetize bounds (on the Options menu) is activated.

2.Drag the selection and position the mouse pointer close to a marker line.
The "drag line" snaps to the marker line.

3.Make sure the marker line and the drag line appear on top of each other, and release the mouse button.
               Related Topics  



Wave Editing - Dragging to a new window 

If you want to turn a section of a wave into a new document, proceed as follows.

1.Make a selection.

2.Drag the selection out of the window and onto an empty section of the WaveLab application window.
The cursor turns into a "new document" icon.

3.Release the mouse.
The selection appears in a new window.

Please note that "Copy to new window" on the Edit menu performs the same operation.
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Wave Editing - Using Cut, Copy and Paste

The following commands lets you copy or move audio from one place to another.

1.Make a selection.

2.If you want to make a copy of the audio, select Copy from the Edit menu, press [Control]-[C] or click the Copy icon
on the Control bar.

3.If you’d rather remove the audio for insertion somewhere else, select Cut from the Edit menu, press [Control]-[C] 
or click the Cut icon on the Control bar.
The audio that was after the Cut section is "moved up" to "fill the gap" that would otherwise be created.

4.If you want to insert the audio, click once at some position in the same file or in another file.
The wave cursor appears at that point. Please note that you can click to get a wave cursor line in one channel 
only or both channels, if the destination is a stereo file.

5.If you'd rather replace a section of audio, select it.
In this case, the position of the cursor is of no relevance.

6.Select Paste from the Edit menu or press [Control]-[V].
The material you cut/copied is either inserted at the indicated point (no selection) or replaces the current 
selection (if you have a selection).

               Related Topics  



Paste Overwrite 

This command on the Paste Special menu, on the Edit menu, will overwrite data in the destination file, rather than 
moving data to make room for the inserted audio.

Exactly how much that gets overwritten depends on the selection in the destination file:
If there is no selection in the destination file, a section with the same length as the pasted data will be 

overwritten.
If there is a selection, the pasted data will replace that selection, just as when making a regular paste.

               Related Topics  



Paste Append and Prepend 

These commands on the Paste Special menu, on the Edit menu, will add the Pasted audio at the beginning 
(Prepend) or end (Append) of the file, just as if you had placed the wave cursor there and selected Paste.
               Related Topics  



Using the Kicker tools 

The Kicker tools in the Toolbox can be used to move audio in a file in small steps.

1.Make a selection.

2.Click on the selection with one of the Kicker Tools (depending on in which direction you want to move it).
The audio is moved one pixel (screen dot). Exactly how much this is depends on how far you are zoomed in. If the
status bar for example says x1:256, the selection will be moved 256 samples.

The moved section "overwrites" whatever audio was at the position it is moved to. If you for example kick 
to the right, silence is inserted before the moved section and the audio coming after it is replaced by the kicked 
selection. This is different from moving by dragging.

If you kick many times in a row and then Undo, all the moves are undone in one go.
               Related Topics  



Resolving Sample Rate Conflicts 

If you copy or move audio from one window to another, and the sample rate of the two files are not the same the 
program will warn you that the copied/moved sound will play back at the wrong pitch (speed) if you proceed. While 
this can sometimes be used as an effect, it is most often not desired. There are two ways to get around this:

Sample Rate convert the source file to the same rate as the destination file before doing the editing.
You might then later go back and Undo this conversion if necessary.

Sample Rate convert the destination file to the same rate as the source file before adding the audio to it.
Please note that you are then partly "stuck" with this new sample rate, since rate converting back and forth too 
many times is not recommended, see Convert Sample Rate.

               Related Topics  



Editing - Repeating

To repeat a section of audio, proceed as follows:

1.Make a selection, select Cut or Copy and place a new insertion point, just as when performing a normal Cut or 
Copy.

2.Select "Multiple Copies" from the Paste Special sub-menu on the Edit menu.

3.In the dialog that appears, enter the number of copies you desire (up to 1000).

4.Click OK.
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Editing - Paste Mix

This command on the Paste Special menu will blend the two sections, starting at the selection (if you have one) or 
at the cursor position (if there is no selection).

All the data on the clipboard is always mixed in, regardless of the length of the selection. It doesn’t matter whether 
you have a selection or not in the destination file when you Paste.
               Related Topics  



Editing - Deleting

There are three ways to delete a selection of audio:
Select Delete from the Edit menu.
Click the Delete icon on the Control bar.
Press [Backspace].
Drag the selection to the Delete icon on the Control bar.

               Related Topics  



Editing - Trimming

To remove all the audio, "outside" the selection, proceed as follows:

1.Select the part you want to keep.

2.Select Trim from the Edit menu or press [Control]-[Backspace].
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Editing - Silencing

There are three ways to replace a section of audio with silence:
Select it and select Silence from the Edit menu.
Select it and click the Silence icon on the Control bar.
Select it and press [Control]-[space bar].
Select it and drag the selection to the Silence icon on the Control bar.
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Editing - Inserting Silence

To insert silence into a section (to space two sections further apart), proceed as follows:

1.Make a selection that starts where you want the Silence to start and that has a length that equals the length of 
the silence you want to insert.

2.Select Insert Silence from the Edit menu or press [Control]+[Ins].
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Editing - Converting mono to stereo

You may convert a mono file into a stereo file that contains the same material in both channels, for example for 
further processing into "real" stereo.

This is done just as when creating a new file (see Creating new Documents - By dragging in an empty area). The 
only difference is that you hold down [Control] while dragging. So, to for example convert an entire file from mono 
to stereo, proceed as follows:

1.Open the mono file.

2.Press [Control]-[A] to select all.

3.Drag the selection out to the WaveLab "desktop".

4.When the pointer is outside the window, hold down [Control] and release the mouse button.
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Editing - Converting Stereo to mono

1.Open the stereo file.

2.Select Save Special from the file menu and then select Convert from the sub-menu that appears.

3.Leave the Sample Rate and Resolution settings as they are, but change the Channels setting to "Mono".

4.Click OK and Save the file.
The channels are mixed and WaveLab makes sure no clipping occurs in the process.

5.Open the file you just saved.
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Creating new Documents - Using New

If you want to start with an empty file, to for example assemble material from other files into this, proceed as 
follows:

1.Select New from the file menu, and Wave from the sub-menu that appears. Or, click the New icon on the Control 
Bar.

2.Fill out the dialog that appears.
See the context sensitive help for details about the various options in the dialog.



Creating new Documents - By dragging in an empty area

If you want to start with an empty file, to for example assemble material from other files into this, proceed as 
follows:

1.Make sure "Create Windows using mouse" is activated in the Display part of the Preferences dialog.

2.Hold down [Control] and drag to make up a box in some "free" area of the WaveLab application window.
This must be of a certain minimum size or bigger. If you don’t get any new window, try again with a bigger box. 
The new window "inherits" its attributes from the last active window. If no window is open, the dialog box settings 
for units, are used instead.



Copying "layouts" between windows

While Snapshots are fine for defining several "layouts" for one window, they do not allow you to copy a "layout" 
from one window to another. For this purpose you can copy layouts between documents. This includes everything 
that is in a Snapshot, plus:

The selection start and end points.
The cursor position.

Here’s how to copy a "layout":

1.Make the window with the desired layout active.

2.Press [Alt]+[Control]-[C].
This copies the layout to an invisible "clipboard".

3.Make the window where you want to apply the layout active.

4.Press [Alt]+[Control]-[V].
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Creating a Snapshot

What are Snapshots for?

Snapshots store the main view’s "layout", which is essentially two things:
How a window is scrolled (which part of the wave you see).
The window’s zoom factor.

If you move back and forth between various positions in a file, or if you zoom in and out for detailed or overview 
editing, using Snapshots will save you a lot of time.

Creating a Snapshot

1.Scroll the window to the desired position.

2.Set the zoom factor as desired.

3.If the Snapshot Palette window isn't already open, select Snapshot from the Window menu.

4 Click on the desired number in the Palette or hold down [Control] and press any of the keys [1] to [8] on the 
typewriter part of the keyboard.
The Snapshot is now stored under that button. The fact the Snapshot is used is indicated by the waveform symbol
turning blue.
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Recalling a Snapshot

There are two ways to recall a snapshot:
Click on the waveform next to the number.
Press any of the keys [1] to [8] on the typewriter part of the keyboard.
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Creating a Marker

Dropping Markers on the fly

To add a marker on the fly, proceed as follows:

1.Play back the file.

2.When the cursor reaches the position where you want a marker, press [Insert] or select Drop Marker from the 
time ruler speed menu.
You can give the marker a proper name later.

Creating a Marker from "stop mode"

1.Set the wave cursor to where you want the marker to appear.

2.Click with the right mouse button on the time ruler.

3.Select New Marker from the menu that appears.

4.Type in the name and click OK.
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Displaying/Hiding Markers
To hide/display the marker triangles from the ruler, click with the right mouse button in the ruler and select

Hide/Show markers.
To hide the marker lines in the waveform, click with the right mouse button in the ruler and select 

Elements. From the menu that appears, set things up so that neither Solid Markers, nor Dotted Markers are 
activated.
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Checking the name of a Marker

1.Make sure Show Tips is activated in the Environment section of the Preferences dialog.

2.Move the mouse pointer over the marker triangle, and wait for a short moment.
The name appears.
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Moving a Marker
To move a marker, press the mouse button over the triangle "Head" and drag to the new position.

Snap to zero crossing applies.
If "Magnetize bounds" on the Options menu is activated the marker "snaps" to the edges of the selection, 

the cursor's position and the beginning and end of the wave.
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Renaming a Marker

1.Double click in the ruler.
The marker window appears.

2.Click with the right mouse button on the marker you want to rename.

3.Select Rename from the menu.

4.Type the new name and press [Return] to end.
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Deleting a Marker

1.Double click in the ruler.
The marker window appears.

2.Click with the right mouse button on the marker you want to delete.

3.Select Delete from the menu.
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Databases - Using Add File

This procedure allows you to add files to a Database by using a file dialog.

1.Select Add from the Database menu.
You can also press the right mouse button in the Location pane and select Add from the menu that appears.

2.Select all files you want to open (possibly using [Shift] and [Control]) and click Open.
The files appear in the List pane. Also, folders are added to the Location pane. These correspond to the real 
folders that the files are in, on the disk.
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Databases - Using Scan Disk

This procedure allows you to add files to a Database by searching for all files that meet certain criteria.

1.Select Scan disk from the Database menu.
You can also press the right mouse button in the Location pane and select Scan disk from the menu that appears.

2.Select a drive and a folder to start searching from.
This folder and all its sub-folders will be searched.

3.Click OK.
The search criteria dialog appears. 

4 Set up the criteria in each of the three tabs and click Scan.
The files that meet all the criteria appear in the List pane. Also, folders are added to the Location pane as needed.
These correspond to the real folders that the files are in, on the disk.

The Three tabs

The Search dialog has three tabs for deciding which files to add to the Database - one for text criteria, one for file 
format criteria and one for date and size criteria.

For a file to get added, it must fulfill the criteria set up in all three tabs. It might for example have to...
have a name containing the text "piano"...
be in stereo, and...
be smaller than one megabyte.

You can of course set up any of the tabs so that all files meet the criteria in this tab, so that you for example can 
add files only based on their naming or only based on their format.

The Text tab

This is used to specify which files to add to the Database, based on Text criteria. See the Context sensitive help in 
the dialog for details.

The Format tab

This allows you to Add files based on their file format. You may activate multiple options in each section to add files 
of different categories (for example both mono and stereo files). See the Context sensitive help in the dialog for 
details.

The Date & Size tab

This tab allows you to specify two things:
If the "Modified" date of the file should be included in the search criteria or not. 
If the size of the file should be included in the search criteria or not.

See the Context sensitive help in the dialog for details.

Using Presets

You can create Presets for this dialog, just as with Processing. See Preset Topics.
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Databases - Adding a Dual Mono file

To add two files as one stereo pair (dual mono) proceed as follows:

1.Add one of the files.

2.Press the right mouse button with the pointer over the file name.

3.Select Properties from the menu that appears.

4.Activate "Other channel file name" and type in the name of the other file in the field below.
The two files will now be treated as a stereo pair when editing, playing etc.
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Databases - Displaying all files in the Database

If you want to display all files in the Database, regardless of location, category, keyword or comment, proceed as 
follows:

1.Select Global Find from the Database menu, and click the Preset tab.

2.Select the "All audio files" Preset and click Load.

3.Click Find.
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Databases - Displaying all files in a Category
To display the files that belong to a certain category, click on that category name in the Category pane.

Please observe that you should click on the Folder name, not on the Folder symbol.
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Databases - Displaying all files in a Folder
To display all the files that reside in a certain Folder, click on the folder in the location pane.

All the files are displayed, regardless of category.
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Databases - Limiting the number of files displayed

Windows 95 puts a limitation on how many files can actually be shown in the file list at one time (around 1500).

Normally you don’t want too many files in the List anyway, since it only makes it harder to organize them and some 
Database operations will take longer to finish.

1.Open the Preferences dialog and click on the Database tab.

2.Adjust the    "Maximum list size" setting.
This sets a limit on how many files will be added in one go.

If you have specified a limit, as described above, it might happen that the list can’t show all the files you expect. If 
this is the case, the Status Bar will indicate this by displaying the number of files in red.
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Databases - Changing List Formats

Just as in the Window 95 Explorer application, you can decide to display the files in different list formats. 

1.Click with the right mouse button in the File list.

2.Select from the lower half of the menu.
For details about each item, select it from the menu, and with the menu still up, press [F1].
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Databases - Sorting Files

If you have selected Show Details as your list format (see Changing List Formats), you can click on the column 
headings to sort the list according to that column’s criteria.
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Databases - Setting Column Width

If you have selected Show Details as your list format (see Changing List Formats), the width of the column headings
can be adjusted.

Point at the divider between two columns, in the heading, and drag left or right.
This setting is saved with the Database.
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Databases - Selecting
You can select one file by clicking on it or by using the cursor keys.
Several files can be selected using [Shift] and [Control] as in other Windows 95 programs.
You can drag a selection rectangle if you start to the right of the actual name.

The files that are inside the rectangle when you release the mouse button will be selected.
To select all files, press the right mouse button in the file list and select "Select All" from the menu that 

appears.
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Databases - Playing Files

To play a file, proceed as follows:
Select the file and click the Play button on the Transport or press [Enter] on the computer keyboard.

If the file is not on any of the disks currently "in the computer" the required disk will be requested. If the file is 
already open and has unsaved changes, the version in the window will be played rather than the one on disk.
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Databases - Opening Files for Editing

To open one or more files in a wave editing window, proceed as follows:
Double click on one file, or...
Select the file(s), press the right mouse button anywhere in the list except on a file name and select Open 

from the menu that appears, or...
Drag the file(s) out of the Database window into an "empty" area within the WaveLab application window.

If the file is not on any of the disks currently "in the computer" the required disk will be requested.
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Databases - Adding Keywords

To set the keywords of one ore more files, proceed as follows:

1.Select the file(s), press the right mouse button anywhere in the list except on a file name, and select Properties 
from the menu that appears.
If you select more than one file you will    give all the files the same keyword(s).

2.Type in each keyword, separated by semicolons (";") or commas (","), or click on the "<<" button and select from 
the menus that appear.
You can enter as many keywords as you like this way. 

Adding Keywords to the menus

You can add Keywords of your own by typing the desired name preceded by a backslash character ("\").

You can even create hierarchic items like on the standard menu. If you for example type "\Quality\Texture\Crystal", 
Crystal will appear on the Texture menu which in turn is on the Quality menu.

The new menus are automatically saved when you close the dialog. You can also modify what keywords are 
available on the menu in new Databases, see Databases - Changing the Default categories.
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Databases - Updating

If you have worked on the files since the Database was last opened, the file attributes (size, date etc) might by "out 
of sync" with the real values. To update those settings, proceed as follows:

1.Select the file(s), press the right mouse button anywhere in the list except on a file name.

2.Select Update from the menu that appears.



Databases - Syncing to Disk

If you open a Database and then edit wave files during a session you will end up with files that have properties that 
don’t match those in the Database. Furthermore you might have created new files which are not in the Database at 
all. The Sync to Disk feature fixes this and other "out of sync" problems.

1.In the Folder list, select the folder you want to update.
The operation will affect this folder and all its sub-folders.

2.Press the right mouse button in the Location pane and select Sync to disk.
The Find dialog appears, see the context sensitive help for details. Also refer to Using Scan Disk.

3.Fill out the dialog or select a Preset to narrow down the operation to files that only meet certain criteria.
If you want to affect all files in the folder(s) select the "All audio files" Preset.

4.Click the Scan button.

The following operations are performed:
Files that are not yet in the Database are added.
Files that don’t exist any longer are removed from the Database.
The attributes (size etc.) of all files in the Database are updated.



Databases - Dragging to Another Database or Project

You can Drag and Drop the files onto other windows. You can drop on:
The List in another Database

This copies the file into that Database. If you hold down [Alt] or [Shift], the files is moved rather than copied.
A Category in another Database

If you drag a file onto a Category in another Database, the files is copied to that Database and added to the 
Category you dropped it on. Use [Alt] to move the file rather than copy it.

A Project window
This copies the file to the Project. You can aim at a certain group to add the file to it.
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Databases - Removing Files

To remove one or more files from the Database, without actually deleting it from disk, proceed as follows.
Select the file(s), press the right mouse button anywhere in the list except on a file name, and select 

Remove from the menu that appears.
If you want to permanently delete the file from disk, use Delete File on the File menu instead.
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Databases - Renaming Files

If you want to rename the file, proceed as follows.

1.Select the file, press the right mouse button, and select Rename from the menu that appears.
If the file is not on any of the disks currently "in the computer" the required disk will be requested.

2.Type in the new name and press [Return]. Do not specify an extension, only the actual file name.
If you need to modify the extension, use the Properties dialog, see Setting Properties.

This operation permanently modifies the actual file name!
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Databases - Setting File Properties

To set the properties of one ore more files, proceed as follows:
Select the file(s), press the right mouse button anywhere in the list except on a file name, and select 

Properties from the menu that appears.
The Properties dialog appears.

See the dialog's context sensitive help for details about the different options.

Please note that the possibility to select more than one file allows you to give a number of files the same 
keyword(s) and comment, in one go.
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Databases - Setting up a Filter

The Filter function allows you to set up criteria so that the list always shows only files that meet a certain criteria. 
You might for example want the list to only display stereo files, regardless of which category or folder you click on.

To set up a Filter, proceed as follows.

1.Select Global Filter from the Database menu.
The dialog that appears is identical to the one used for Scan Disk.

2.Fill out the dialog or select a Preset, see Using Scan Disk.

3.Click OK.

Now when you click around on folders or categories, only files that meet the criteria set up in the dialog are 
displayed. You can note that a filter is applied by checking the Status bar, where it says "Global Filter".

The filter is common to all open Databases.
Deactivating the Filter



Databases - Deactivating the Filter

To completely turn off Database Filtering, proceed as follows.

1.Select Global Filter from the Database menu.

2.Click on the Preset tab, select "All audio files" and click Load.

3.Click OK.
Setting Up a Filter



Databases - Performing a Find operation

WaveLab’s Find feature allows you to find all files in the Database that match certain criteria.

Please note that the Find function only searches among files already added to the Database (which is different from 
how Scan Disk works, see Using Scan Disk).

Limiting the Search
If you want to search among all files in the Database, select Global Find from the Database menu.
If you want to search in a folder and its subfolders, click the right mouse button on that folder and select 

Find.
If you want to search among files in one category only, click on that category with the right mouse button 

and select Find.
If you only want to search among the files currently in the list, click on the right mouse button in the list 

and select Find.
In either case, the same Find dialog appears.

Performing the Find

The Find dialog is basically the same as the one used for filtering and for Scan Disk (see Using Scan Disk). The three
tabs allow you to specify different types of criteria for the search. You can also select from Presets.

Set up the dialog and click Find.
The found files appear in the Database.

If you have selected Global Find, you can activate "Keep Window open". This allows you to redo the search 
without closing the dialog.

The Filter setting applies (see Setting Up a Filter). You might for example have set up a Filter that ensures 
that only stereo files are shown in the list. Then when you perform a Find, you will still only get stereo files in the 
list. Please note that this might result in no files at all being shown. An example of this would be that you try to find 
only mono files and have a Filter that only displays stereo files.
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Databases - Renaming Folders

You can rename a folder in the location pane    (not the real folder on disk):

1.Click on the folder with the right mouse button.

2.Select Rename.
The folder name opens up for editing, just as on the Windows 95 Desktop.

3.Change the name and hit [Return].

Note that if the folder name in the Database an on the disk do not match, you can not open the files in that folder 
from the Database.
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Databases - Removing Folders

To remove a folder and all the files in it from the Database, proceed as follows:

1.Click on the folder (in the location pane) using the right mouse button.

2.Select Remove.

3.Click OK in the dialog that appears.

This does not delete the actual files from disk. It only removes them from the Database.
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Databases - Adding files to a Category

1.Make sure the desired category is visible in the list.
If it isn’t, open the desired folder and scroll the list, to make it visible.

2.Select the Files in the list, that you want to make part of a certain category.

3.Drag the selected files and release them on the desired Category folder.
The files disappear from the list.

Please note that you can add a file to any level in the category "hierarchy". you can for example make a file part of 
the category "Instrument", you don’t have to put it into any of the subcategories ("Keyboards", "String" etc).
               Related Topics  

Moving files between Categories
Displaying all files in a Category
Displaying all files not in any Category
Databases - Checking with Category a file belongs to
Databases - Creating Categories



Databases - Moving files between Categories

If you drop a file onto another Category than it is already in, it is moved from the old Category to the new. In other 
words, files can only be in one Category at a time.
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Databases - Displaying all files in a category
To display the files that belong certain category, click on the category name.

Please observe that you should click on the Folder name, not on the Folder symbol.
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Databases - Displaying all files not in any Category

There might be instances when you want to display all the files that you haven’t yet been put into any category:

1.Press the right mouse button in the Category pane.

2.Select "Find Unregistered items" from the menu that appears.
               Related Topics  



Databases - Checking with Category a file belongs to

If you have a file in the list and are unsure of which category it belongs to, proceed as follows:
Select the file, press the right mouse button in the list and select "Show Folders" from the menu that 

appears, or...
Hold down [Alt] and click on the file name or wave icon in the list.

Either way, the category folder is highlighted in the list. If no folder is highlighted, this means the file doesn’t 
belong to any category.

This operation also tells you which folder the file is in, check the Location pane.
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Databases - Creating Categories
To create a new category, select the folder you want this new category to be in. Then press the right 

mouse button and select "New Category". Type in the name and click OK.
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Databases - Renaming Categories
To rename a category, select it,    press the right mouse button and select Rename from the menu that 

appears. Type in the new name and click OK.
               Related Topics  



Databases - Removing Categories
To delete a category folder, select it press the right mouse button and select Remove from the menu that 

appears.
This deletes the selected category and all its subcategories.

The files that belonged to these categories are not deleted. Rather they become "unregistered items", see 
Displaying all files not in any Category.
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Databases - Changing the Default categories and keywords

To change the Category hierarchy and keyword lists that appears in new Databases, proceed as follows:

1.Make copies of the files "categ.txt" and "keywords.txt"
These are located in the System folder in the WaveLab folder. You might for example name the copies "categ.bak"
and "keywords.bak".

2.Launch a regular text editor.
One of those included with Windows will work fine.

3.To Edit the categories, open the file "categ.txt". To edit the keywords, open "keywords.txt".
Note how the files are structured:

Each level in the hierarchy begins with the name. After this, the sub-items within this level are listed inside 
curly brackets ("{" and "}"). For example, in the "categ" file you will note a section that begins with the word 
"Keyboards" followed by a left bracket on the next line. This category ("Keyboards") does not end until after the 
word "Harpsichord", since on the line below that, a corresponding right bracket appears.

Within each level you will in many cases find sub-levels, also enclosed in curly brackets. (In programmer 
speak, this is referred to as nested structure). In the "Keyboard" example, the sub-levels are "Organ", "Piano", 
"Synth", "Celesta", "Clavinet" and "Harpsichord". The first three of these contain their own subcategories.

4.Change the structure, rename, add and remove items as desired.
Make sure that each left bracket is "balanced" by a right bracket ending the "level".

5.Save the file under the same name in the same location.

If something goes wrong, delete the files you have created and rename the backup files to the original names. This 
will give you the initial settings back.
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Wave Attributes Dialog
This dialog appears whenever you need to specify a format for your audio. It allows you to set the quality (Bit 
resolution and Sample rate) and a general format (mono, stereo or dual mono).
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.



With this activated, you will get a mono (one channel) audio file.



With this activated, you will get a regular stereo (two channel) audio file.



With this activated, you will get a stereo (two channel) audio file, but which is handled as two separate mono files. 
Use this to stay compatible with other recording systems which store stereo as two mono files.



With this activated, your recording will be in 8-bit format. 8-bit files are by nature noisier than 16-bit files. On the 
other hand they occupy less disk space.



With this activated, your recording will be in 16-bit format. 16-bit files have very little inherent noise. On the other 
hand they occupy twice the disk space of 8-bit files.



The first five buttons in this section allow you to specify one of a number of pre-set sample rates. If you select the 
sixth option you can specify any rate (between 2000 and 48000Hz). The higher the sample rate, the higher the 
audio quality and the more disk space needed. 44.1kHz is the format used on CDs. 22kHz is the format used in 
most games and multimedia applications.



Click this button to close the dialog and accept the settings.



Click this button to close the dialog without changing the settings.



Style Dialog
This dialog is used to save Styles. A Style contains all the settings you can make on the Elements and Colors speed 
menus in the wave display. Please note that all settings can be made individually for the main view and overview 
and also individually for each channel. Once the display is styled as you like it, open the Style Save dialog, select 
one of the "slots", type in a name and click OK.
Once this is done, you can apply the style to any wave document by selecting it from the Style menu on the Options
menu.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.



The Style you specify in this "slot" is the one that will be used for all new and newly opened wave documents.



Use the radio buttons to select a Style slot to save the current Style in. Use the name field to specify a name for the
Style.



Click this button to close the dialog and accept the changes.



Click this button to close the dialog without making any changes.



Record Dialog
This dialog is used for recording new files. It allows you to set up a format, open the Mixer, activate monitoring, 
adjust levels and more.
For information about the recording procedure, check the following links:
Basic Recording Procedures
Recording - Checking Levels
Recording - Using the mixer
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.



This text shows you what format your recordings will have. To change the format, click the Edit button.



This button opens the Wave Attributes dialog, allowing you to specify a format for your recording.



These show the recording level. Avoid "hitting the red"!



These show the strongest signal that has passed through the card since you opened the dialog or clicked the Reset 
button. This indication should not reach the "0.0" level.



This activates the Meters and the Peak text indicators. If you click the Play button, this setting is automatically 
deactivated.



This resets the Peak text indicators.



While you record, this text shows you how long your recording is.



This shows you an estimate of how much free space you have left on your hard drive, in recording minutes.



If you experience glitches in your recordings, activate this button. This is only a temporary fix, necessary because 
some audio card drivers do not work as intended under Windows 95. Contact your dealer to get the latest Windows 
95 specific driver for your audio card.



Click this button to activate recording.



Click this button to play back the current wave (usually the most recently made recording).



Click this button to open    the Mixer. Click the Help button for more info on the Mixer.



When you are done with your recordings, click this button to close the dialog.



Normalize Dialog
This dialog is used to change the gain (volume) of a selection. The amount of gain change is always set relative to 
full level. The idea behind this is to allow you to optimize the gain of low level wave files.
If the selection is in stereo, the channels are searched separately to find the highest peak, but the amount of gain 
change is applied equally to both channels (so as to not disturbe the stereo balance).
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This is used to set the level. True normalization, (increasing volume to maximum level) is obtained by setting 
"Maximum level" to 0dB, 100% or 32767, depending on which unit is used.



This will automatically set "Maximum level" to the amplitude of the level selection made (see Level Selections).



This button will check the selection for the strongest signal and display how far from full level this is. Use this as a 
diagnostic tool to decide for example if the wave needs normalizing or not. 



Click this button perform the processing.



Click this button to close the dialog.



Gain Change Dialog
This dialog is used to change the gain (volume) of the selection. It differs from Normalize in that the change in 
volume is specified as an absolute value. Hence, this dialog allows you to change the gain to more than "full level" 
and thereby introduce clipping.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



The amount of level change. "0" means no change, positive values amplify and negative values attenuate.



The specified gain change as a percentage value.



This button will check the selection for the strongest signal and display how far from full level this is. Use this as a 
diagnostic tool to decide how much gain change to apply.



Click this button to perform the processing.



Click this button to close the dialog.



This is used to specify how many copies of the data on the clipboard to paste in into the active window.



Click this button to perform the Paste.



Click this button to close the dialog without making any changes.



Preferences Dialog
This dialog is used for making a number of overall settings for the program. Please note that to make these settings
"stick" until the next time you use the program, make sure "Save Preferences on exit" on    the "General" tab is 
activated.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.



With this activated, a hint as to what each button on the Control Bar does will be displayed if you leave the pointer 
over the button for a short moment. By the same token, names of markers will be shown when you leave the 
pointer over a marker head.



This is used to set the size of the buttons on the various Toolbars.



This is used to hide/show the Status bar altogether.



This is used to set a size for the fonts on the Status bar, Medium or Large.



When this is activated, all newly opened and created windows will have a sample overview pane to start with (this 
can be hidden later). When it is deactivated, they will not.



When this is activated, all additional windows for editing the same file, will also have a sample overview pane. 
When it is deactivated, they will not.



This is used to have the zoom factor    (mainly of the overview) adjusted automatically so that the entire wave is 
always displayed. To try it out, zoom out the overview all the way and adjust the width of the window. The zoom 
factor is adjusted automatically. For more info, see Zoom Topics.



When this is activated, you can drag in a free area of the application window to create new windows. See Working 
with multipe windows of the same data.



This is used to set the magnification factor of new windows. The setting is in seconds.



This should be activated, unless you have a very slow computer, in which case deactivating this option will speed 
up the waveform drawing a bit, while sacrificing screen redraw smoothness.



This setting is only used for time rulers set to the "meter" option. For the program to be able to display a proper 
meter scale, you need to here specify the Time Signature of the music in the wave you are editing.



This setting is only used for time rulers set to the "meter" option. For the program to be able to display a proper 
Meter scale, you need to here specify the Tempo of the music in the wave you are editing.



This setting is only used for time rulers set to the "meter" option. For the program to be able to display a proper 
Meter scale, you need to here specify the Tempo of the music in the wave you are editing.



This is used to specify the number of frames per second (FPS) for time rulers set to Time code:
24 FPS This is the format used for 35 and 70 mm film.
25 FPS This is the format used for video in Europe.
29.97 FPS This is the format used for most video editing in the United States.
30 FPS This is also used in the United States, mostly for audio only applications.



Click this button to close the dialog and accept the changes.



Click this button to close the dialog without keeping any changes (but the toolbar settings).



With this activated, zero crossing detection is automatically turned off at zoom factor of 1:4 or higher (check the 
status bar to see you current zoom factor).



This is used to set how far WaveLab should search in each direction for a zero crossing, before "giving up". If you for
example have a recording with a DC offset, there might not be any zero crossings at all during low level passages. 
This value can normally be left as it is.



These two options (Left and Right) allow you to set whether either side of the selection should be extended to a 
zero crossing point followed by a slope in a certain direction, or whether any zero crossing will do. The normal 
setting is to have both these set to either Upward Slope or Downward Slope.



These two options (Left and Right) allow you to set whether either side of the selection should be extended to a 
zero crossing point followed by a slope in a certain direction, or whether any zero crossing will do. The normal 
setting is to have both these set to either Upward Slope or Downward Slope.



When this is activated, a level selection can not be made unless the [Shift] key is pressed. When this is deactivated,
level selections can always be made.



When this is activated, cursors will be in color. Please note that under Windows 95, color cursors might flicker a bit, 
especially during drag and drop operations. If this is a problem, deactivate this option.



With this activated, the number of Undos/Redos is only limited by your hard disk space. However, during long 
editing sessions this will successively fill up the hard disk. If you have limited hard disk space you might decide to 
uncheck this box and set a limit.



When Unlimited is deactivated, this can be used to set how many Undo/Redo stages should be allowed.



When this is activated, the value editing sliders will be vertical. See Setting values in dialog boxes and windows.



When this is activated, the value editing sliders will be horizontal. See Setting values in dialog boxes and windows.



This is a very important setting. It is used to set where WaveLab should store all its temporary files, as required for 
Undo and other operations. There are three considerations for where to put these files:

Position: We recommend you to create a special folder for these files, so that you can easily track any stray
files down and delete them if necessary.

Hard disk size: The available disk space for these files determine how many Undo/Redo stages you can 
have.

Hard disk speed: The speed of the hard disk where you put your temp files affects the perceived speed of 
the program.

Compression: Do not specify a volume where you have applied overall file compression!



Click this button to find a location for the Temporary files. For more info, see the help on the path field just above 
this button.



If this is activated, two mono files can be opened as a stereo pair. See Opening Files Topics.



When this is activated, the Wave files created by WaveLab will be compatible with Digidesign’s Session 8 system. 
This will increase the size of each file by approximately 4000 byte. The files are still compatible with other programs
that read Wave files.



With this activated, time positions in dialogs will be shown as hours, minutes, seconds, milliseconds (thousands of a
seconds).



With this activated, time positions in dialogs will be shown as bars, beats and ticks. The tempo and number of ticks 
per quarter note is set in the Tempo/Time code section of this dialog.



With this activated, time positions in dialogs will be shown as hours:minutes:seconds:frames. The number of frames
is set in the Tempo/Time code section of this dialog.



With this activated, time positions in dialogs will be shown as number of samples. Exactly how many samples there 
are in a second depends on the sample rate. For 44.1kHz for example, there are 44100 samples per second.



With this activated, level settings in dialogs are indicated as a percentage of "full level" (sometimes referred to as 
"no headroom").



With this activated, level settings in dialogs are indicated in dB. -96 is "zero level" and 0 is "full level".



With this activated, the actual value of the sample is used to indicate levels in dialogs. In fact, the sample range is 
from -32767 to 32767 where 0 is "no level" and either other value is "full level" However, in practicality, one only 
needs to specify ranges from 0 to 32767.



With this activated, the dialog boxes will show levels in the same format as the ruler in the wave window is set to. If 
you change the ruler unit while a dialog box is open, the changes take effect immediatly.



With this activated, the dialog boxes will show positions in the same format as the ruler in the active window is set 
to. If you change the ruler unit while a dialog box is open, the changes take effect immediatly.



If the Database can not find a certain file it may check the floppy disk drives. This may take some time, so if you 
don’t want the program to take the floppy disks into account when searching for files, uncheck this option.



WaveLab needs to know which drive letters that are used for your floppy drives. The most common options are "A" 
and "B", but in some countries the standard is to use "C "and "D". Normally, this is set correctly, automatically.



With this activated, you will get a warning message when you try to delete a file from a Database or a Project. When
this is deactivated, you don’t get any warning message.



When performing a search (Scan) in a Database, you might theoretically get a list of thousands of files. This is most 
often not desirable since the scan may then take very long and Windows doesn't allow "infinitely" long lists. 
Therefore the program will stop searching after the number of files specified here have been added to the 
Database. It will then display the number of files in red on the Status bar. Use this as an indication that you should 
probably narrow down the search criteria to get fewer files added to the Database.



With this activated, the next time you launch WaveLab, the same windows will be opened as were open when you 
last Quit the program.
To override this setting, hold down [Control] when you launch the program.



With this activated, all your Preference settings are automatically saved when you Quit the program.



This is used to select which language to use in the program. For the change to take effect you have to restart the 
program.



This is used to decide which sound card should be used for playback. See the installation chapter in the printed 
documentation.



This is used to decide which sound card should be used for recording. See the installation chapter in the printed 
documentation.



This is used to check whether your audio card supports the most common formats for playback. The following 
checks are made:

Does the card support 44.1, 22 and 11kHz sample rates?
Does the card support 8 and 16 bits formats?
Does the card support mono and stereo?



This is used to check whether your audio card supports the most common formats for recording. The following 
checks are made:

Does the card support 44.1, 22 and 11kHz sample rates?
Does the card support 8 and 16 bits formats?
Does the card support mono and stereo?



Use this field to type in the position you want to move the cursor to.



Click here to close the dialog and move the cursor.



Click this button to close the dialog without making any changes.



The Preset Tab
Presets are used to predefine settings for a certain dialog. By recalling a Preset and applying it, you can perform 
processing or other action (depending on the dialog) without making any settings at all!
For step by step instructions on Preset handling, click on this item: Preset Topics
For more information about each item in the Preset tab, use the context sensitive help (the question mark symbol) 
in the actual dialog.



These shows the existing Presets for this dialog. To select one click on it. To load one, double click on it.



This shows the currently loaded Preset. It is also used to specify a name for a Preset before adding.



Click this button to load the Preset selected in the list.



Click this button to create a new Preset. The new Preset will get the current settings in the dialog and the name 
indicated on the line above the buttons.



Click this button to delete the Preset selected in the list.



Click this button to replace the settings in the Preset selected in the list with the ones currently set up in the dialog.



Frequency Graph Dialog
The frequency graph allows you to view a wave file in the frequency domain rather than in the time domain. 
Although a wave display (time domain) tells you a lot about for example where one sound starts or ends in a file, it 
doesn’t say anything about the timbral contents of the file. A frequency graph (frequency domain) does.
The graph used in WaveLab is actually something often referred to as an FFT (Fast Fourier Transform) plot.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.

Displaying the Graph
Adjusting the Graph



Click this button to redraw the Frequency Graph with the new settings specified.



Click this button to close the dialog and accept the changes.



Click this button to close the dialog without making any changes.



When this is activated, color/gray scale will be used to indicate the amplitude of the frequencies in the graph.



When this is activated, color/gray scale will be used to indicate the frequencies in the graph.



When this is activated, amplitude or frequency (see the settings above) will be indicated in color.



When this is activated, amplitude will be indicated in gray scale.



When this is activated, the graph will be in black and white. In this mode, the screen is redrawn faster than in the 
other modes.



When this is activated, the background behind the graph will be black.



When this is activated, the background behind the graph will be white.



This is used to set the lowest frequency to display. This setting must be at leas three octaves lower than the "To" 
value below.



This is used to set the highest frequency to display. This setting must be at leas three octaves (three times the 
frequency) higher than the "From" value above.



When this is activated, the frequency range will be displayed linearly in the graph.



When this is activated, the frequency range will be displayed logarithmically in the graph.



By clicking these radio buttons you can set any point of view to the graph's level and frequency axises.



When this is activated, the amplitude range will be displayed linearly in the graph.



When this is activated, the amplitude range will be displayed logarithmically in the graph.



Time Stretch Dialog
Time stretch is an operation that allows you to change the length of a recording without affecting its pitch. Actually 
the standard term "time stretch" is a bit misleading since you can of course also make the material shorter.
This function most often used to make a section of audio fit in with some other material. Therefore this dialog is set 
up exactly for that. You select the material to be stretched and use the options in the dialog to find a stretch factor 
(the "Ratio"). This is done by specifying the desired length, or the desired tempo, all according to what the situation 
requires. You can also specify the Ratio directly as a percentage value of the original length.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This is the original length of the selection, in samples.



This is the original length of the selection, in seconds.



This allows you to specify the original tempo of the selection, if you want to specify the stretch as a tempo change. 
If you have a meter based ruler, it will change accordingly. This setting changes the one found in the preference 
dialog.



This allows you to specify the length of the selection in bars, beats and ticks to calculate a source tempo, if you 
don't already know it.



This allows you to specify the time signature of the selection. Only used if you specify the length of the selection in 
bars. If you have a meter based ruler, it will change accordingly. This signature setting changes the one found in the
preference dialog.



This is used to specify the desired length, in samples.



This is used to specify the desired length, in seconds.



This is used to specify the desired tempo. For this to work, the tempo related fields in the Source section must have 
been filled out accurately.



If you want the selection to fit a certain time code range, specify the start point of that range here.



If you want the selection to fit a certain time code range, specify the end point of that range here. Do not start by 
adjusting this value, since it is relative to to the time code start value.



This sets the Ration to "100.000%" (no stretch).



This is the amount of stretch that will be applied when you click Process.



Click this button to perform the processing.



Click this button to close the dialog.



Hi-fi Chorus Dialog
This chorus works slightly different from many others. Often chorusing is achieved by delaying a copy of the signal, 
varying the amount of delay continuously and mixing the delayed signal back in with the original.
While this is adequate for many purposes, WaveLab takes a more natural approach to creating chorus. Since a 
chorus effect is basically about making a recording sound like it was performed by many "identical musicians", 
WaveLab takes just that approach. It multiplies the recording up to 100 times (using the same high quality pitch 
shifting engine as in the pitch correction and harmonizer), and detunes and delays each "voice" slightly and - if so 
desired - pans the voices across the stereo image.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This allows you to specify how many voices will be used. The higher the number, the "richer" the sound. This 
number is always at least 2 (the original plus one detuned copy). If you create stereo waves, the double number of 
voices specified here will be generated. The more voices the longer the processing will take.



This is used to set how much variation in pitch is allowed (maximum). The higher the setting, the more detuned the 
sound will be.



This allows you to set how much maximum delay that the program can apply to each voice. The higher the number,
the richer the sound, but higher numbers will also "blur" the attack and increase the length of the sound.



This allows you to set how the amount of pitch change should be distributed across the voices. With Narrow 
selected, more voices are close to the original in pitch. With Linear selected, the pitch change is distributed equally 
across the voices. With Wide selected, more voices are detuned close to the maximum allowed number of cents.



This sets the level of the detuned voices relative to the original sound. The higher the number, the more you will 
hear of the detuned voices.



When this is activated, the resulting audio will have the same level as the original, even though a number of voices 
have been added. Even if this is not activated, clipping never occurs.



If you are operating from a mono selection you can still create a stereo wave by activating this option. The 
processed wave will then open in a new window.
The Chorus is a great way to create stereo sounds out of mono ones.



Click this button to perform the processing.



Click this button to close the dialog.



Pitch Correction Dialog
Pitch Correction is a function which allows you to change pitch of a sound, with or without affecting its length.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This allows you to specify the amount of pitch change in semitones. The maximum range is ±36 semitones (±3 
octaves). 



This allows you to specify the amount of pitch change in cents. This adjusts the pitch within one semitone, that is, 
50 means a quarter note.



This allows you to set how the length of the selection should be affected by the operation.
A setting of 100 means that the length of the audio will be the same after the operation.
A setting of 0 means that the program will behave like when you change the speed on a tape recorder. For 

example, if you raise the pitch by one octave, the sound will become half as long.
Intermediary values will give results in between these two extremes. 

For large transposition values, the lower this setting is, the better the quality of the effect will be.



Click this button to perform the Pitch Correction.



Click this button to close the dialog.



Harmonizer Dialog
This is a variation on the Pitch Correction which allows you to create not only one shifted voice, but up to sixteen!
See the printed documentation for step-by-step instructions on how to set up this dialog.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This is used to select which voice to make settings for.



This is used to activate/deactivate the selected voice.



This is used to specify the amount of pitch shift for the selected voice, in semitones. The maximum range is ±36 
semitones (±3 octaves). Smaller values lead to a better sound quality.



This is used to specify the amount of pitch shift for the selected voice, in cents. This adjusts the pitch within one 
semitone, that is, 50 means a quarter note.



This is used to set the relative level (volume) for the selected voice.



This sets the pan position of the selected voice, that is it's left right position in the stereo image.



When this is activated, the resulting audio will have the same level as the original, even though a number of voices 
have been added. Even if this is not activated, clipping never occurs.



If you are operating from a mono selection you can still create a stereo wave by activating this option. The 
processed wave will then open in a new window.



This text tells you how many voices are currently activated.



Click this button to perform the processing.



Click this button to close the dialog.



Sample Rate Conversion Dialog
This function allows you to change the sample rate of a recording. This is very convenient if you have a file that you
wish to use in a certain audio system and find that the file was recorded at a sample rate this system doesn’t 
support.
Sample Rate conversion is always applied to the entire file. Any selection you have made is not used in any way for 
this operation.
Please note the following:

Sample rate conversion from a low frequency and up does not improve sound quality. The high frequencies
that were lost due to a low recording frequency can not be restored by a conversion.

When you Sample rate convert down to a lower frequency, high frequency material will be lost (this is part 
of the mathematics behind digital audio). Therefore, do not convert down and then up again, since this will lead to a
degradation in sound quality (if that isn’t exactly what you’re after!). Instead, use the Undo and Redo functions.

Do not sample rate convert from 44.1 to 48kHz in an effort to improve sound quality. This won’t give you 
any improvement in sound and many audio cards do not support playback of 48kHz at all.

When converting from 44.1 to 11kHz, it might make sense to activate Top quality, to avoid "aliasing" 
artifacts that might otherwise occur.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This is used to set the desired sample rate.



This is good sample rate conversion. This quality is adequate for many applications. However, for sounds with many
high frequencies, the other quality setting might be more appropriate.



This is extremely high quality sample rate conversion. Please note that with this option activated, the processing 
takes much longer to finish.



Click this button to perform the processing.



Click this button to close the dialog.



Find Dialog
This dialog is used for the following operations:

Scan Disk
Sync to Disk
Global Filter
Find and Global Find

The dialog allows you to set up criteria for which files the operation should affect. Please note that the settings in all
three tabs are always used.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.



This allows you to specify whether the operation should only apply to Wave and/or AIFF files.



This allows you to specify whether the operation should only apply to mono, stereo and/or dual mono files.



This allows you to specify whether the operation should apply to 8 and/or 16 bit files.



This allows you to specify which sample rates the operation should apply to. To allow any sample rate, activate 
"Any". To specify the sample rate yourself, activate the bottom option and type in a number.



If you are looking for file names, keywords or comments, type in the text to search for, on this line.



If you are looking for keywords, select the desired keywords from this menu. You can select as many as you like.



With this activated, the operation will apply to files based on their file names.



With this activated, the operation will apply to files based on their keywords.



With this activated, the operation will apply to files based on their comment text.



With this activated, the text on the query line will be interpreted as "one long string".



With this activated, words on the line separated by spaces will be interpreted as one text item each. Only files that 
contain all the words in their names, keywords or comments will be affected by the operation.



With this activated, words on the line separated by spaces will be interpreted as one text item each. Files that 
contain any of words in their names, keywords or comments will be affected by the operation.



With this activated, you can keep the window open to perform multiple finds without closing in between. This option
is not available for all the functions this dialog is used for.



Click this button to perform the Scan/Find/Sync to Disk operation.



Click this button to reset the settings in all three tabs to default values.



Click this button to close the dialog without making any changes.



With this activated, files will be affected by the operation regardless of their "Modified date".



With this activated, files will be affected by the operation if they have been modified since yesterday.



With this activated, files will be affected by the operation if they have been modified during the last week.



With this activated, files will be affected by the operation if they have been modified on or before a certain date 
that you specify.



With this activated, files will be affected by the operation if their "Modified date" is set to the specific date you 
specify.



With this activated, files will be affected by the operation if they have been modified on or after a certain date that 
you specify.



In this field you specify the date for the "Find on or before", "Find exact" and "Find on or after" options.



With this activated, files will be affected by the operation regardless of their file size.



With this activated, files will be affected by the operation only if their file size is smaller than specified here.



Use this field to specify a file size for the "Smaller than" option.



Database Properties Dialog
This dialog allows you to check and change the properties of one ore more files.
Please note that the possibility to select more than one file allows you to give a number of files the same 
keyword(s) and comment, in one go.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.



This gives you information about the format, size and modified date of the file.



This is the file’s regular name including the file type extension. Changing this is the same as changing the file name
in the Explorer or other file managing utility. This can not be edited if you have selected several files or if a file is on 
CD-ROM.



When this is activated, you can specify a file name for the other file in a dual mono pair. This can not be edited if 
you have selected several files.



This field is used to specify the name of the other file in a pair of mono files constituting a stereo recording (dual 
mono). This can not be edited if you have selected several files.



To add keywords to the file(s), type in each keyword on this line, separated by semicolons (";") or commas (","). You 
can enter as many keywords as you like this way. 



To add keywords to the file(s), click on the "<<" button and select from the menus that appear. You can enter as 
many keywords as you like this way.
You can also add Keywords of your own to the menu. Type the desired name preceded by a backslash character 
("\"). You can create hierarchic items like on the standard menu. If you for example type "\Quality\Texture\Crystal", 
Crystal will appear on the Texture menu which in turn is on the Quality menu.



In this field you can type in any comment you’d like to add to the file. This information can also be used when you 
want to find files that meet certain criteria. 



Click this button to close the dialog and accept the changes.



Click this button to close the dialog without making any changes.



Volume Name Dialog
If you try to add files to a Database or Project from a volume (hard disk or similar) that hasn’t been given any name,
the program will prompt you for such a name. This is required for WaveLab so that it can keep track of which files 
are on which disk (for example with removable hard disks).
The Volume name you specify will appear in all programs that display detailed disk information (like for example the
Explorer).
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.



Here you type in the name you'd like to give the volume.



Click this button to close the dialog and accept the change.



Click this button to close the dialog without making any changes.



Type in the name of the category in this field.



Click this button to create the new category.



Click this button to close the dialog without making any changes.



Type in the name of the group in this field.



Click this button to create the new group



Click this button to close the dialog without making any changes.



Type in the name of the marker in this field.



Click this button to create the new marker.



Click this button to close the dialog without making any changes.



Batch Processing Dialog
Batch Processing allows you to do two things:

Apply more than one type of processing, in one go.
Apply the same processing to more than one file at a time.

Of course you can do both these two things at the same time.
Batch processing can be applied to a list of files, or to the active wave (the one in the top window).

For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.

Assembling a List of files
Assembling a list of Tasks
Changing the order of Tasks
Editing settings for Tasks
Using Presets



Click this button to perform the Batch processing.



Click this button to close the dialog (settings are kept).



This list displays the files that will be processed. You can select one or more files in the list. If no file is selected, the 
current wave will be processed.



This button brings up a regular file dialog allowing you to add files to the "Files to process" list.



This button removes the selected file(s) from the list.



This button removes all files from the list.



If you want to replace the old files with the processed versions, activate this option.



If you want to create new files, activate this option and set up a path (folder) to put the files in.



When this is activated, a backup of each file will be created before it is processed, to avoid accidental deletion of 
files. The first letter in the extension of the file will be replaced by the character "~" in the backup.



When "Create new files" is activated, use this field to specify a path (folder) for the new file.



This button can be used to specify a path from a file dialog box (by pointing and clicking).



New files will have the same name as the old file, preceded by the text you type in in this field. Additionally, you 
can have a suffix.



New files will have the same name as the old file, appended by the text you type in in this field. . Additionally, you 
can have a prefix.



This pop-up is used to set the format for the new files, Wave or AIFF.



This is the list of tasks to be performed on the files. The tasks will be performed in the order in the list, from the top 
and down. To deactivate a task without removing it from the list, click the check box for that task.



This is the list of possible tasks to add to the list of tasks to be performed. See Batch Processing Topics.



This inserts the task selected in the "Processor pool" into the "Tasks to perform list". The task is inserted above the 
selected task. 



This adds the task selected in the "Processor pool" at the end of the "Tasks to perform list". 



This moves the selected task in the "Tasks to perform list "one step up.



This moves the selected task in the "Tasks to perform list" one step down.



This removes the selected task from the "Tasks to perform" list.



This removes all tasks from the "Tasks to perform" list.



This opens the settings dialog for the task selected in the "Tasks to perform" list.



Equalization Dialog
This is an equalizer, with two shelving filters (high and low) and a parametric band with adjustable Q (width). The 
purpose of an EQ (filter) is to adjust the timbre of a sound, to for example reduce the amount of bass or increase 
the amount of treble contents.
The graph indicates the total filter curve produced by the three sections together.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This graph indicates the total filter curve produced by the three filter sections together.



This is used to adjust in which range of the lower spectrum the Low Shelf filter should operate.



This is used to set how much the signal should be boosted (positive numbers) or cut (negative numbers) in the 
lower range.



This is used to adjust the center frequency of the mid range filter.



This is used to set how much the signal should be boosted or cut at the Mid Range Frequency.



This is used to set the width of the mid range filter. The higher this number, the wider the filter and the larger the 
part of the spectrum that will be affected.



This is used to adjust in which range of the higher spectrum the High Shelf filter should operate.



This is used to set how much the signal should be boosted or cut in the high range.



Click this button to perform the processing.



Click this button to close the dialog.



Dynamics Dialog
This dialog allows you to tailor the dynamics of the audio, to create effects like compression, expansion, limiting and
noise gating. Dynamic processing of audio is a big subject. Please refer to the printed documentation and also 
please study the included Presets which implement examples of the above mentioned functions.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



Click this button to perform the processing.



Click this button to close the dialog.



This is used to set up the input to output level relation:
You can drag any break-point in the curve to any position, using the left mouse button.
When you move breakpoints closer to the left side or the bottom of the graph, you will note that the 

number of positions is more limited. This is due to the nature of digital audio, where for lower levels, a smaller 
number of "bits" is used to represent the data.

You can add a new breakpoint by clicking anywhere on the curve with the left mouse button.
You can delete a breakpoint by clicking on it with the right mouse button.



If this is activated, all the three other time response settings are adjusted automatically. For simple compression, try
this first. Remember you can always undo and try again with other settings.



This is the time it takes for the processor to adjust the amplitude according to the curve, when the signal rises up.



This is the time the processor will "hold the gain" before moving to the release phase.



This is the time it will take for the processor to adjust the amplitude according to the curve when the signal is fading
out and the Hold time has expired.



When this is activated, you can specify the input to output level relation by clicking in the graph. See the context 
sensitive help for the actual graph, for details.



Only signals above this level will be affected. Signal below this level pass through the processor unaffected.



The amount of gain reduction for signals above the Threshold level. The range is from 1 (no reduction) to 10 (very 
close to limiting).



When this is on, the signal will be normalized to the set level before the processing is applied. It can for example be 
used when processing a number of files with slightly different levels. Please note that since normalization will most 
likely raise the level of the input signal to the processor, it may drastically influence what effect the processing has. 
This means that after activating this you may have to adjust the Threshold level. A reason for setting this to less 
than 0 (full level) is if you are expanding, which can introduce clipping if the signal is too strong to start with.



When this is activated, the audio will be normalized after the processing has been finished.



This is used to specify the highest desired level in the signal before the dynamics operation occurs.



This is used to specify the highest desired level in the signal after the dynamics operation has been performed.



This restores the curve to a straight line with only one breakpoint.



This adds a breakpoint at the level indicated by the current level selection (see Level Selections).



This applies to stereo signals only. With this option selected both channels are "read" and processed as in a regular 
compressor.



This applies to stereo signals only. With this option activated, the left channel will be read and the right will be 
processed. This allows you to for example "gate" one signal to the amplitude of the other, or to create ducking 
effects.



This applies to stereo signals only. With this option activated, the right channelö will be read and the left will be 
processed. This allows you to for example "gate" one signal to the amplitude of the other, or to create ducking 
effects.



With this activated, the function monitoring the signal to decide when to apply gain change will take shorter peaks 
into account. If you experience clipping when using Average mode, try this option.



With this activated, an average of the signal level is used to determine when to apply gain change. This is the most 
common setting as it sounds more natural.



When this is activated, two channels in a stereo recording will be treated as one, when processing. That is, the 
same gain change will be applied to both channels. The normal mode for stereo recordings is to have this option 
activated.



When this is activated, the function that scans the wave to determine when level reduction should be applied, 
actually "runs ahead" of the actual processing. How much it "runs ahead" is set with the Attack parameter. This 
means that when a transient (peak) appears in the audio, compression based on that peak is already being applied.
This setting has much weight for recordings with many transients.



Fade Dialog
The Fade In and Out    items on the Level menu actually open the same dialog, but with different options activated.
A Fade In is a gradual increase in level and a Fade Out is of course the opposite. As you adjust the values, a curve 
indicating the fade is drawn in the wave display.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



With this activated, the function will create a fade in starting at the selection startpoint and ending at the selection 
endpoint.



With this activated, the function will create a fade out starting at the selection startpoint and ending at the selection
endpoint.



This setting determines where in the fade section the file will play at its "mid level" (half the level).



This adjusts the "steepness" of the fade. For example, a -6dB setting for a fade-in will result in a normal fade, where
the level is half the original when it reaches the Offset point. Values closer to 0dB will emphasize the beginning of a 
fade-in. Values closer to -18dB will emphasize the end of a fade-in. Check the curve drawn in the wave display.



Click this button to apply the fade.



Click this button to close the dialog.



Crossfade Dialog
A crossfade is a gradual fade between two sounds, where one is faded in and the other is faded out. This function 
allows you to do just that. It also lets you create plain mixes of two sounds. As you adjust the values, curves 
indicating the fade is drawn in the wave display.
For detailed step-by-step instructions, see the printed documentation.
For more information about each item in the dialog, use the context sensitive help (the question mark symbol) in 
the actual dialog.
See also Using non-modal dialogs.



This setting determines where in the fade section the fade-out file will play at its "mid level" (half the level).



This adjusts the "steepness" of the fade-in. For example, a -6dB setting is the "normal" value, where the level of the
fade-in file is half the original when it reaches the Offset point. Values closer to 0dB will emphasize the beginning of 
the fade-in. Values closer to -18dB will emphasize the end of the fade-in.



This automatically sets the fade-out curve to the inverse of the fade-in curve.



With this activated, the fade-out section will not be faded at all, but rather mixed in at full level.



This setting determines where in the fade section the fade-in file will play at its "mid level" (half the level).



This adjusts the "steepness" of the fade-out. For example, a -6dB setting is the "normal" value, where the level of 
the fade-out file is half the original when it reaches the Offset point. Values closer to 0dB will emphasize the end of 
the fade-out. Values closer to -18dB will emphasize the beginning of the fade-out.



This automatically sets the fade-in curve to the inverse of the fade-out curve.



With this activated, the fade-in section will not be faded at all, but rather mixed in at full level.



Click this button to perform the Crossfade.



Click this button to close the dialog.





Opening multiple Files

You can open a number of files at the same time.

1.In the Open dialog, select as many files as you wish.
This is done using [Shift] and [Control], as in any Windows 95 program.

2.Click Open.
They all appear in one window each.

               Related Topics  



Opening Dual Mono files

If you have two mono files which are actually the left and right channels of a stereo recording (some systems 
handle stereo this way), you can open these as if they were a stereo file. Proceed as follows:

Allowing Opening of Dual Mono files

1.Pull down the Options menu, select Preferences and click on the File tab.

2.Make sure the "Allow opening of dual mono files" is activated.

3.Close the dialog.

Opening Dual Mono files

1.Select Open Wave from the file menu.

2.Select the first file, hold down [Control] and select the other.

3.Click Open.
The two files are opened as one stereo file. The file names determine which file becomes the left channel and 
which becomes the right. The one that comes first in the alphabet becomes the left channel. If this is not as 
desired, you can Swap Channels.

You can now work on the two files as if they were one. You can later save them as a stereo file or as two mono files. 
See Save Convert.
               Related Topics  



Dragging and Dropping files

To open one or more files from the Desktop or the Explorer, use any of the three following possibilities:
Drag and drop the file(s) on the WaveLab application window.
Drag and drop the file(s) on the WaveLab program icon or a short-cut for it.

If the program isn’t already running, it will be launched. Also, this works even if the application is running but 
minimized.

Double click on the file.
This will only works if you have created an association between the file format and the WaveLab application. Such
an association can be set up automatically during installation.

               Related Topics  



Opening a recently used file

On the bottom of the file menu the ten last opened files will be listed. To open one of these, simply select it.

Using this option allows you to open a dual mono file (actually two files) that you have previously worked on, with 
one mouse click!
               Related Topics  



Save Convert

If you want to change the format (sample rate, bit resolution and stereo/mono) when saving, proceed as follows:

1.Select Convert from the Save Special menu, on the File menu.

2.Fill out the first dialog.
See the context sensitive help for details.

3.A regular file dialog appears where you can specify a file name, folder and a file format.
A new file is created. The original file is not affected by the operation. If a file with the same name already exists, 
you are asked whether you want to back up the existing file first.

The following operations are performed:
Sample Rate If a new sample rate is specified, a sample rate conversion is performed with "Standard Quality".

Bit resolution If a different bit resolution is specified, the file is either "truncated" down to 8 bits or "padded up" to 
16 bits. If you convert to 8 bits, the audio is automatically normalized.

Mono/Stereo If the file is converted from mono to stereo, the same material appears in both channels. If the 
conversion is from stereo to mono, a mix of the two channels is made.

               Related Topics  



Creating Session 8 compatible files

The Digidesign Session 8 system uses special Wave files. To make your files compatible with the Session 8, proceed 
as follows:

1.Select Preferences from the Options menu.

2.Click on the File tab.

3.Make sure the "Save Session-8 compatible WAV files" option is activated.
This raises the file size by about 4 kByte, which is a relatively small amount. Please note that the files are still 
compatible with other programs that read Wave files.

               Related Topics  



Deleting files

To delete a file from disk, proceed as follows.

1.Make sure the file isn’t currently being edited in window.

2.Select Delete File from the File menu.

3.In the file dialog that appears, select the file and click Open.
A warning dialog appears telling you the file will be permanently deleted from disk and can not be brought back.

4.Click Yes.



Save
If you have opened a file and modified it, you can save the changes into the same file, by simply selecting 

Save from the File menu or by pressing [Control]-[S].
When you save a new document for the first time, it doesn’t matter whether you select Save or Save As. 

The Save As dialog will appear anyway, since you need to specify a file format, folder, and file name.
Saving clears the Undo buffers, which means that after saving you can not undo or redo.

               Related Topics  



Save As
If you have an unsaved file, or if you want to specify a new name, location and/or file format for a 

previously saved file, you should select Save As from the File menu.
A regular file dialog appears. The pop-up menu at the bottom can be used to select a file format. If a file with the 
same name already exists, you are asked whether you want to back up the existing file first.

After a file has been saved once, you can continue to edit it and then select Save to update the file and 
make the changes permanent.

Saving clears the Undo buffers, which means that after saving you can not undo or redo.
               Related Topics  



Saving one channel only

The "Save left/right channel as" menu items are also on the Save Special sub-menu. They allow you to save each 
channel individually, into a separate file. A regular file dialog is used, see Save As.

This menu command is used specifically when you have been editing "dual mono" files and wish to save the 
channels in the file separately.
               Related Topics  



Saving a Copy

The    "Save Copy" item, on the Save Special sub-menu, allows you to save a copy of the file, in its current state, 
without affecting the original. A regular file dialog is used, see Save As.
               Related Topics  



Saving Databases and Projects

There is no special save command for Databases or Projects. Instead, any changes you make are automatically 
saved to disk as you go along. If you close a Database or Project and then Open it you will find it exactly as you left 
it (to instead open a Database with a standard layout, hold down [Control] when opening).

You might work a lot on your Databases, adding files into Categories etc. Please back the Database files up, in case 
you experience data loss. Database files are not very big compared to Wave files.
               Related Topics  



Reverting to the last Saved version

The Revert to Saved menu option, on the File menu, allows you to revert the file back to its last saved state 
(actually, the last saved version of the file is loaded from disk). This can be used as kind of "super undo" where all 
the changes you have made to the file since you last saved are undone.

1.Select Revert to Saved from the File menu.

2.Click "Yes" in the warning dialog that appears.
The files is restored to its last saved state.



Automatic Backups
For all save operations except a "plain Save" you will be asked whether you want to create a backup, if a file with 
the same name already exisits in the folder. If you click Yes in this dialog, the first letter in the extension of the 
exisiting file will be changed to "~". "AIF" for example, will become "~IF".





Optimizing the virtual memory settings

If you use Windows 95 (as opposed to Windows NT) it is important that your virtual memory settings are correct, to 
optimize the speed of various operations in WaveLab.

1.Make sure no programs are running.

2.Click on the Start button on the Taskbar and select the Control Panel.

3.In the Control Panel window, double click on System.

4.Click the Performance tab.

5.Click the Virtual memory button.

6.Click on the button "Let me specify my own virtual memory settings".

7.Specify 20 (MegaBytes) as the minimum, and between 20 and 40 as the maximum.
The maximum settings depends on how much hard disk space you can "afford" to devote to this and how much 
RAM you have. The less RAM, the larger this file should be. The optimum setting is two and a half times the 
amount of RAM you have.

8.Click OK, Yes, Close and Yes in the dialogs that appear.
The computer will get restarted.



Optimizing the color settings

You might want to optimize the number of colors you use when you run WaveLab.
WaveLab operates best in 256 color mode.
16 colors is on some systems slightly slower than 256 colors, and doesn’t let you take full advantage of 

WaveLab’s color capabilities.
Thousands of colors (or more) is not advised since it will make WaveLab run slower and consume more 

memory than in the other modes.

See your Windows documentation for instructions on how to change the number of colors used on your computer.
               Related Topics  



Setting up the audio card

You need to "inform" WaveLab of which audio card you want to use:

1.Select "Preferences" from the Options menu.

2.Click on the "General" tab.

3.Select the audio card you want to use for recording and playback, from the Devices pop-ups.
If you only have one audio card you can possibly also select the "Microsoft Sound Mapper" options, (the Sound 
Mapper is a "virtual audio card" which "maps" all audio to your real card). However this does not let you take full 
advantage of the card’s driver when recording, and is therefore not recommended.

               Related Topics  



Deciding where "temp" files are put

You need to specify where WaveLab should store its temporary files. Temporary files are mainly used for Undo, as 
explained below.

1.Create a separate folder to store your "temp" files in.
This is done from the Desktop, using the Explorer or the File Manager (depending on what Windows version you 
are using).

This folder should be on your fastest hard disk and you should make sure you have plenty of room available on that 
hard disk (or partition).

2.In the Preferences dialog, click the File tab.

3.Either type in the path to the directory or click the Browse button to locate and select the folder.

Save the Preferences

To make permanent the settings you just made, proceed as follows:

1.Click on the General tab in the Preferences dialog.

2.Make sure that "Save preferences on exit" is activated.

3.Close the Preferences dialog.

Temp files and Undo

When WaveLab needs to create a file for Undo, it puts this in the "temp" folder you have specified and gives it the 
extension "$$$". These files are automatically deleted when you quit WaveLab or when you use Purge Undo. If you 
find any such files when you are not running WaveLab, you can delete them.
               Related Topics  



Checking which formats the card supports

You can check whether your audio card supports the three most common sample rates.

1.Select Preferences from the Options menu.

2.Click on the General tab.

3.Click the two question mark icons to find out which sample rates and bit resolutions are supported for playback 
and recording, respectively.

Unfortunately, there is no provision in Windows for checking all sample rates that a card supports, so the result of 
this test only tells whether these three rates are supported or not. The card may still support other rates. Please 
check the user documentation for the card.
               Related Topics  



Setting values in dialog boxes and windows

In dialog boxes, you will find yourself adjusting values. The following techniques apply:

Typing Values

Like in most other Windows programs you can "tab to" or click directly on a value and type in a new one.

Using the Spin Controls

All values can be set using the regular Windows spin controls – two arrows pointing up/down.
Clicking either arrow raises/lowers the value.
Keeping the mouse button pressed over an arrow makes the value "scroll".
Holding down [Control] makes the value change in larger steps.
Holding down [Control]+[Shift] changes the value to its minimum/maximum.
The last adjusted control can be changed using the up and down arrow keysÿ] keys, also in combination 

with [Control] or [Control]+[Shift] as described above.

Using Sliders and pop-ups

Many times, the most convenient way to change a value is using WaveLab’s proprietary sliders and pop-ups:

1.Click with the right mouse button on the spin control.

2.If a pop-up menu appears, select one of the options on it.

3.If one or more sliders appear, drag the handle(s) or click the arrows to set the value.
The setting is shown in the value box "behind" the slider window.

4.When you are done, click outside the slider window.
If the value is "segmented" (for example divided into minutes and seconds etc), more than one slider will 

appear, each used for adjusting one of the "segments".
The slider window can be dragged to any position on the screen, using the "title bar" at the top.
The last used slider can be adjusted using the up and down arrow keys on the computer keyboard.



Setting up Preferences

In the Preferences dialog (reached from the Options menu) you will find a number of settings that can be used to 
tailor the look and behavior of the program.

The settings are collected on tabs. To find out what each one does, please use the context sensitive on-line help.

Saving the Preferences

To make sure the Preference settings "stick", proceed as follows.

1.Open the Preferences dialog and click on the General tab.

2.Make sure "Save preferences on exit" is activated.
               Related Topics  



Creating start-up Preferences

To make sure the program starts with one and the same Preference settings each time you launch it, proceed as 
follows:

1.Set up all Preferences as desired.
See Set up Preferences

2.Make sure "Save preferences on exit" is activated.

3.Quit the program.

4.Launch the program again, and deactivate "Save preferences on exit".
Now you can change the Preferences for this session, but the settings you had when you last Quit will be the ones
you get the next time you launch the program.

               Related Topics  



Checking the available hard disk space

The available disk space for recording and Undo is limited by the size of the disk where you store your temporary 
files.

To find out how much disk space you have available on each of your volumes, select "Free Disk Space" 
from the File menu.

The window that appears displays this information both graphically and as a number.



Putting a limit on the Undo function

If you run out of hard disk space or if you are applying processing to extremely long sections of waves, you might 
want to put a limit on the Undo function:

1.Select Preferences from the Options menu.

2.Click on the Editing tab.

3.Uncheck the "Unlimited" option in the Undo/Redo section.

4.Change the Limit number to the desired value.
               Related Topics  



Clearing the Undo function

There might be situations where you have "collected" a large number of Undo possibilities that you know you don’t 
need. You might then clear the whole Undo "buffer" for one file at a time. This will free up some primary memory 
(RAM) but more importantly it will also delete all the "undo files" from your hard disk, to free up space.

1.Select "Purge undo" from the Edit menu.
A window appears informing you of how much RAM and hard disk space you will gain by this operation.

2.Click OK.

Please note that this function only works on one document at a time. It is only the Undo buffer for the file in the 
active window that will be cleared.
               Related Topics  



Displaying the Clipboard
If you want to see the contents of the WaveLab clipboard (not the main Windows clipboard), select 

Clipboard from the Edit menu and Show from the sub-menu that appears.
The Clipboard window opens.

The Clipboard is a Wave window like any other (it is always in stereo) and any type of editing can be applied to it 
except those involving Cut, Copy or Paste. You can even Undo and Redo operations on the Clipboard!
               Related Topics  



Clearing the Clipboard

If the clipboard is wasting hard disk space for other Temporary files, you way want to clear it.
Pull down the Edit menu, select Clipboard and from the sub-menu that appears, select Clear.

               Related Topics  



Key Commands - File Handling
[Control]-[O] Open wave file
[Control]-[S] Save current wave
[Control]-[N] Create new wave
[Control]-[W] Close current document (and all its related windows)



Key Commands - Zooming

Main view
[G] Zoom in horizontally
[H] Zoom out horizontally
[J] Zoom out to display entire wave horizontally
[Shift]-[G] Zoom in vertically
[Shift]-[H] Zoom out vertically
[Shift]-[J] Zoom in or out to get an optimized level display (best fit)
[K] Zoom selection

Overview
[Control]-[G] Zoom in horizontally
[Control]-[H] Zoom out horizontally
[Control]-[J] Zoom out to display entire wave horizontally
[Control]+[Shift]-[G] Zoom in vertically
[Control]+[Shift]-[H] Zoom out vertically 
[Control]+[Shift]-[J] Zoom in or out to get an optimized level display (best fit)



Key Commands - View and Snapshots

Adjusting the View
The following commands scroll the window without moving the cursor
[Control]+[Alt]-[Home] Start of Wave
[Control]+[Alt]-[End] End of Wave
[Control]+[Alt]-[Page Up] One window width to the left 
[Control]+[Alt]-[Page Down]One window width to the right 

Snapshots
The number keys referred to below are the ones on the typewriter part of the keyboard, not on the numeric key 
pad. Furthermore these refer to the keys on an American keyboard. Other countries may have other key caps on the
same keys.
[1] to [8] Recall snapshot 1 to 8
[Control]-[1] to [8] Store snapshot 1 to 8



Key Commands - Playback and Cursor position

Numeric key pad
[Enter] Play (from current position)
[0] Stop / Move to selection start / Move to beginning
[1] Move cursor to selection start
[2] Move cursor to selection end
[4] Move cursor to previous marker
[5] Move cursor to next marker
[.] (full stop) Scroll to cursor
[/] Loop on/off (current wave only)

Function keys
The following keys are available even if a dialog is the active window!
[F8] Play (from current position)
[F6] Play selection
[Shift]-[F6] Turn on Loop and play selection
[F7] Stop / Move to selection start / Move to beginning
[F5] Empty the playback buffers

Cursor keys
[ ] Move cursor one pixel left
[ ] Move cursor one pixel    right
[Control]-[ ] Move cursor 20 pixels left
[Control]-[ ] Move cursor 20 pixels right
[Page Up] Move cursor 20 pixels left
[Page Down] Move cursor 20 pixels right
[Control]-[Page Up] Move cursor one window width left
[Control]-
[Page Down] Move cursor one window width right
[Home] Move cursor to beginning
[End] Move cursor to end
[Tab] Toggle Cursor between left/right/both channels (stereo waves only)



Key Commands - Selecting
[Esc] Toggle selection on/off
[Tab] Toggle selection between left/right/both channels (stereo waves only)

Extending or making selections
The following commands create a new selection or extend the current one.
[Shift]-[ ] One pixel to the left
[Shift]-[ ] One pixel to the right
[Control]+[Shift]-[ ] 20 pixels to the left
[Control]+[Shift]-[ ] 20 pixels to the right
[Shift]-[Page Up] 20 pixels to the left
[Shift]-[Page Down] 20 pixels to the right
[Control]+[Shift]-
[Page Up] One window width to the left
[Control]+[Shift]-
[Page Down] One window width to the right

Making selections
The following commands always create a new selection
[Shift]-[Home] From cursor to start
[Shift]-[End] From cursor to end
[Control]-[A] Select all

"One the fly" numeric key pad commands
The following commands are for selecting during playback. Please note that the keys on the numeric key pad must 
be used.
[Shift]-[1] Set start of selection
[Shift]-[2] Set end of selection
[+] Press and hold to set start of selection, release to set end of selection.



Key Commands - Editing and Recording

Cut and Paste
[Control]-[X] Cut
[Control]-[C] Copy
[Control]-[V] Paste
[Control]+[Shift]-[V] Paste Append
[Alt]-[Control]-[C] Copy Wave window layout to an invisible clipboard
[Alt]-[Control]-[V] Paste clipboard to restore Wave Window Layout

Delete and Silence
[Backspace] Delete current selection
[Control]-[space bar] Silence current selection
[Control]+[Shift]-
[Insert] Insert silence
[Control]-
[Backspace] Trim (to selection)

Recording
[*] (multiply on 
num key pad) Open Record dialog

Undo and Redo
Please note that the    function key Undo and Redo commands are available even if a dialog is the active window!
[Control]-[Z] Undo
[F3] Undo
[Control]+[Shift]-[Z] Redo
[F4] Redo



Key Commands - Processing
[N] Normalize
[D] Dynamics
[F] Fade out
[Control]-[F] Fade in
[X] Crossfade
[T] Time stretch
[P] Pitch Correction
[Q] EQ 
[Control]-[B] Batch processor



Key Commands - Markers
[Control]-[M] Open marker list
[Insert] Drop new marker at cursor position (for example during playback)
[Control]-[Insert] Create Marker



Key Commands - Database
[Insert] Add file to database
[Control]-[D] Scan Disk
[Control]-[F] Global Find
[Control]-[G] Global Filter



Key Commands - Miscellaneous
[F2] Toggle focus between the dialog and the document window
[Control] - [F2] Open list of open windows
[Alt] - [Control] - [M] Maximize Wave window width
[F9] Show/hide Control bar
[F10] Show/hide Toolbox
[F11] Show/hide Snapshots
[F12] Show/hide Transport
[Control]-[P] Open Preferences dialog
[M] Magnetize Bounds on/off
[Z] Zero crossing on/off
[Control]-[Page Up] Switch to the previous page of a tabbed dialog
[Control]-[Page Down] Switch to the next page of a tabbed dialog



The Wave Window

This is the main WaveLab window. It is here that you perform all the basic audio editing.
There are more operations related to the wave window than it makes sense to create direct links to. 

Instead, to get a list of all the Wave window operations, please click at the Contents button at the top of this 
window. Open the "How to" book icon and check out the following groups and their topics:

Basic Wave Operations
Layout Copying, Wave Snapshots and Markers
Wave Processing
File Handling

Window Panes

The Wave window is divided into an overview (at the top) and a main view (at the bottom). These views are shown 
in two panes, separated by a divider. You can change the size of each pane. You can even hide the overview 
completely. To find out more, check the following topics:

How to Adjust pane sizes
How to Hide Panes
How to Reveal Panes



The Database Window

The Database window allows you to organize a large number of files sensibly. You can put files into categories and 
add keywords and comments to each. You can then for example find all bass drums on all your media with one 
single click!. the Database even allows you to find files on disks (CD-ROMs for example) that are not even in the 
computer!
Once the files are found you can play them or open them for editing.

There are more operations related to the databases than it makes sense to create direct links to. Instead, 
to get a list of all the Database operations, click at the Contents button at the top of this window. Open the "How to"
book icon and check out "Database operations" group and its topics.

Window Panes

The Database window is divided into three panes: The Location pane (showing where on the disks your files are), 
the Category pane (showing which category a file is in) and the File list (showing the currently found files). You can 
change the size of each pane. To find out more, check the following topic:

How to Adjust pane sizes



The Project Window

The Project window allows you to organize all files that belong to a certain project, into groups. For a radio 
commercial, for example, you might have one group for sound effects, one for narration and one for music. This can
be done even if the files are not in the same folder or even on the same disk!

You can play the files in the Project, or open them for editing.
               Related Topics  



The Free Disk Space window

This window displays the available disk space on all your connected disks.



The Frequency Analysis window

This window displays the selection as a frequency graph. To make settings for the graph, double click on it, right-
click on it or select "Frequency Analysis" from the Options menu. For more info, see the on-line help Contents and 
Index.
               Related Topics  



The Marker window

This window lists the current window's markers and allows you to rename or delete them.

The list is by default sorted alphabetically but you can change the sort order by clicking on the headings.
               Related Topics  





Creates a new empty Wave window. You will be asked to specify attributes for the wave.



Locate and create a new empty Project window.



Locate and create a new empty Database window.



Allows you to open Wave files via a standard Windows file dialog.



Allows you to open a Project via a standard Windows file dialog. Opening a project will close all currently opened 
documents. Only one project can be opened at a time.



Allows you to open Databases via a standard Windows file dialog.



This reverts the active wave file to its last saved state. Use this as a super-undo to undo all changes you made since
you last saved.



This closes the active window (and all its related windows).



This saves any changes made to the active wave document. If the document hasn't ever been saved, the Save As 
dialog appears instead.



This saves the active wave document under the name and in the location that you specify. A regular Windows "Save
As" dialog appears.



This works just as Save As, only it allows you to change the format of the wave when saving. For more info, see 
Saving Files Topics



This works just as Save As, only it creates a copy of the wave without affecting the original.



This allows you to save only the left channel of a wave, in a separate file. The dialog that appears is the regular 
Windows "Save As" dialog.



This allows you to save only the right channel of a wave, in a separate file. The dialog that appears is the regular 
Windows "Save As" dialog.



This opens the Batch Processing dialog.



This displays information about the active document.



This opens up the Free Disk Space window.



This allows you to delete a file permanently from disk. A regular file dialog appears allowing you to select which file 
should be deleted.



This is used to quit (exit) WaveLab.



This part of the menu lists the last opened files. Selecting one opens it. One advantage of using this is that it allows 
you to open dual mono files with one click.



Opens the Preferences dialog.



Opens the Frequency Analysis Setup dialog.



Selecting on of these options applies the selected Style to the active Wave window. For more info, see Styles Topics



This opens up the Style management dialog.



When this is activated, the wave window will scroll automatically on playback so that the cursor is always in the 
window. However, this does not apply to playback using the Play tool.



This will play back the audio in 8-bit (low quality format). For more info, see Playing with 8-bit resolution.



When this is activated, selections will snap to the closes zero crossing. For more info, see "Selecting" Topics.



When this is activated the following items become "magnetic":
The Start and End of the entire wave.
The Start and End of the selection.
The wave cursor.
The Time ruler origin, if different than 0.
Marker.

This is used in the following operations:
When positioning the cursor by clicking or dragging in the ruler.
When creating or adjusting a selection.
When positioning markers.
When dragging and dropping a selection.



This arranges all open windows in an overlapping pattern.



This adjusts all open windows so that they appear side by side.



This stacks all open windows vertically.



This adjusts all open windows so that they appear under each other.



This arranges all minimized WaveLab documents in a neat order at the bottom the WaveLab window.



This closes all WaveLab document windows, regardless of type, as well as non-modal dialogs.



This closes all WaveLab Wave windows.



This minimizes all WaveLab document windows, regardless of type.



This closes all WaveLab Wave windows.



This restores all minimized WaveLab windows, regardless of type.



This restores all minimized WaveLab Wave windows



This shows/hides the Transport.



This shows/hides the Snapshot window/toolbar.



This shows/hides the Toolbox.



This shows/hides the Control Bar.



This is a list of ten of the open WaveLab documents, regardless whether their windows are open or minimized. 
Selecting one makes it the active window.



If you have more than ten documents open, this presents a list of them, in a window. Double clicking one makes it 
the active window.



This takes you to the on-line help Contents, Index and Find dialog.



When this is activated you will get a tip (in a Help window) each time you launch WaveLab. There are tens of tips.



This opens a dialog telling you which version of WaveLab you are running.



This allows you to undo your operations. There is no real limit to the number of operations that can be undone. For 
more info, see Undo Topics.



If you have undone something and change your mind, this item allows you to redo it! There is no real limit to the 
number of operations that can be redone. For more info, see Undo Topics.



This item opens up a window that allows you to clear the Undo buffer, if it uses up to much of your hard disk space. 
After this you will not be able to undo or redo the operations previously performed. For more info, see Undo Topics.



This removes the selected item and puts it in an invisible storage area called the Clipboard. You can then Paste it in 
somewhere else. For more info, see Clipboard Topics and Basic Editing Topics.



This copies the selected item to an invisible storage area called the Clipboard. You can then Paste it in somewhere 
else. For more info, see Clipboard Topics and Basic Editing Topics.



This take the data on the Clipboard and pastes it in into the active window. If you have no selection, the paste 
happens at the cursor. If you have a selection , it gets replaced by the pasted data. For more info, see Clipboard 
Topics and Basic Editing Topics.



This is just as a regular Paste. The only difference is that it overwrites the data from the cursor position and 
onwards, rather than inserting the data.



This is just as a regular Paste but the data is added at the end of the wave.



This is just as a regular Paste but the data is added at the beginning of the wave.



This allows you to repeat material. Cut or Copy and then use this item to specify how many times the material 
should be pasted in.



This pastes in the data, but mixes it with the existing material, rather than replacing or inserting.



This removes the selected material from the wave.



This item deletes everything but the selection.



This selects the entire wave.



This creates a selection from the cursor to the beginning of the wave. Or, if you already have a selection , it extends
it to the beginning of the wave.



This creates a selection from the cursor to the end of the wave. Or, if you already have a selection, it extends it to 
the end of the wave.



This sets the level selection to the highest peak in the current time selection. For more info, see the Selecting 
Topics.



This turns the selection on and off.



This copies the selection into a new (automatically created) window.



This replaces the selection with silence.



This inserts a section of silence into the wave, with the same length as the selection and beginning where the 
selection begins.



This swaps the selected material between the left and right channels in a stereo wave. Note that you must select 
across both channels for this command to work.



This opens up the Clipboard window, which contains the last cut or copied material. For more info, see Clipboard 
Topics.



This clears the contents of the Clipboard (which contains the last cut or copied material).



This opens up the Normalize dialog.



This opens up the Change Gain dialog.



This inverts the Phase of the selection (turns the curve upside down). For more info, see Invert Phase.



This removes any DC offset in the selection. For more info, see Eliminate DC Offset.



This open up the Fade In dialog.



This opens up the Fade Out dialog.



This opens up the Crossfade dialog.



This opens up the Dynamics dialog.



This turns the selection backwards.



This opens up the Time Stretch dialog.



This opens up the Pitch Correction dialog.



This opens up the Harmonizer dialog.



This opens up the Chorus dialog.



This opens up the EQ (Equalization) dialog.



This opens up the Sample Rate Conversion dialog.



Selecting this item opens up a regular Windows file dialog where you can select the file(s) you want to add to the 
Database.



This item first opens up a small file dialog box where you can decide on which drive and folder to start searching for
files. After this, yet another dialog appears allowing you to specify criteria for which files to add to the Database. For
more info, see Using Scan Disk.



This opens up the Global Find dialog.



This opens up the Global Filter dialog.



This displays the file in a list where the columns show details about each file.



This displays the files in a simple list, without any information about each one.



This displays the files as small icons.



This displays the files as large icons.



Selecting this item plays the selection only. You can also press [F6] to do the same thing.



This changes the zoom factor so that the selection fills the entire window.



This hides/shows the time ruler.



This hides/shows the level ruler.



With this activated, marker lines are shown as solid lines. When neither this nor "Dotted markers" are active, 
marker lines are not shown at all.



With this activated, marker lines are shown as dotted lines. When neither this nor "Solid markers" are active, 
marker lines are not shown at all.



This moves the barber pole striped range indicator to the top of the overview.



This moves the barber pole striped range indicator to the bottom of the overview.



These three menu items set the width of the cursor line (thin medium or fat).



When this is activated, a solid line stretches through "the middle" of the wave. When neither this nor "Dotted zero 
level axis" are activated, no line at all is shown.



When this is activated, a dotted line stretches through "the middle" of the wave. When neither this nor "Solid zero 
level axis" are activated, no line at all is shown.



When this is activated, a solid line stretches through the +/- 50 levels in the wave. When neither this nor "Dotted 
half level axis" are activated, no line at all is shown.



When this is activated, a dotted line stretches through the +/- 50 levels in the wave. When neither this nor "Solid 
half level axis" are activated, no line at all is shown.



These menu items allow you to select a color for each element of the wave display.



This creates a new window which contains a second view to the same document.



This sets the window to the maximum possible width.



This open the Marker window allowing you to view, rename and delete markers.



This scrolls the view to the beginning of the wave, without changing the cursor position.



This scrolls the view to the end of the wave, without changing the cursor position.



This scrolls the view to the start of the selection, without changing the cursor position.



This scrolls the view to the end of the selection, without changing the cursor position.



This scrolls the view to the cursor.



This sets the cursor at the beginning of the wave and scrolls the view there.



This sets the cursor at the end of the wave and scrolls the view there.



This sets the cursor at the start of the selection and scrolls the view there.



This sets the cursor at the end of the selection and scrolls the view there.



This sets the cursor at an arbitrary position you specify in a dialog.



This finds the highest peak in the current selection, and moves the cursor position there. If the wave is in stereo, 
the cursor only appears in one channel, the one with the highest peak.



This opens the Frequency Analysis window. For more info, see Frequency Graph Topics.



This allows you to rename a folder in the Location pane. Please note that this does not rename the real folder on 
disk.



This removes a folder and all items in it, from the Database. It does not remove any files from disk.



This item allows you to update the Database so that it is in sync with what is really on the disk. For more info, see 
Syncing to Disk.



This allows you to find items, in the Database, that are located in a certain folder. For more info, see File Operation 
Topics.



This adds a new category to the list. It is added as a sub-category to the selected category.



This allows you to rename a category.



This removes the selected category. Any files in this category become Unregistered items. For more info, see 
Category Topics.



This allows you to find items, in the Database, that belong to a certain category. For more info, see Category Topics.



This makes the file list display all items in the Database that do not belong to any category.



This open the selected file(s) for editing.



This opens up the Properties dialog allowing you to make settings for the selected file(s).



When you select a folder and select this item, the Location pane shows you which folder the file is in. The Category 
pane also shows you which category the file is in.



This updates the properties of the selected file(s) so that they show the real values (as stored on the disk).



This allows you to rename the file. This renames the real file on disk. Do not enter an extension!



This removes the file. Please note that the file is not deleted from disk, only removed from the Database.



This selects all files currently visible in the list.



This allows you to find files among the ones currently visible in the list. For more info, see File Operation Topics.



This allows you to add one or more files to the selected Group. A regular file dialog appears allowing you to select 
which file(s) to add.



This creates a new Group, as a sub-group to the selected Group.



This allows you to rename a Group or File, depending on what is selected.



This opens the selected file(s) for editing.



This removes the selected Group/file from the Project. For files, please note that the file is not deleted from disk.



This creates a new marker at the current cursor position. It allows you to specify a name for the marker as you 
create it.



This adds a marker with a default name at the current cursor position (you can change the name later). You can also
press [Insert] to perform the same action. Please note that this cam be done even during playback.



This makes the ruler show positions in the format hours:minutes:seconds and milliseconds.



This makes the ruler show positions as samples. Exactly how many samples there are in a second depends on the 
sample rate. For 44.1kHz for example, there are 44100 samples per second.



This displays positions as hours:minutes:seconds and frames. How many frames there are per second depends on 
the frame rate setting. For more info, see Ruler Topics.



This displays positions as bars, beats and ticks. For more info, see see Ruler Topics.



This displays positions in kiloBytes and MegaBytes.



This sets the ruler "0" position to the current cursor position.



This sets the ruler "0" position to the beginning of the file.



This is used to hide the time ruler. To get it back press the right mouse button in the wave display, select 
"Elements" and then "Time ruler".



This is used to hide/show marker heads from the time ruler.



With this selected, the time ruler is shown as "3D" numbers on a gray background.



With this selected, the time ruler is shown as part of the wave display.



This allows you to pick a font, size and style for the text on the time ruler.



This allows you to set a color for the tick marks on the time ruler.



This displays levels as a percentage of full level (100%).



This displays levels in dB.



This displays levels as decimal numbers which represent the real sample values stored in computer memory.



This is used to hide the level ruler. To get it back press the right mouse button in the wave display, select 
"Elements" and then "Level ruler".



With this selected, the level ruler is shown as "3D" numbers on a gray background.



With this selected, the level ruler is shown as part of the wave display.



This allows you to pick a font, size and style for the text on the level ruler.



This allows you to set a color for the tick marks on the level ruler.



This allows you to rename the marker. Select this menu item, edit the name and press [Return].



This removes the marker from the list and the wave window.





Apply Processing in General 

To apply processing to a selection, proceed as follows:

1.Make a selection.

Many times you will want to "Select All" to process the entire file. If the file is in stereo, you can apply processing to 
either channel or both, by selecting one channel or both, See Selecting.

2.Select the desired type of processing from the Level and Process menus.

3.If a dialog appears, fill it out.
If the dialog uses Presets, you can load one of them to fill out the settings automatically, see Applying a Preset.

4.When you are done with the settings in the dialog, click the Apply/Paste/Process button.
The Status Bar shows the progress of the operation. If you need to cancel, click the Stop button on the Status bar,
or press [Esc].

               Related Topics  



Applying a Preset

1.Open the Processing dialog you wish to use and click on its Presets tab.

2.Double click on the Preset you want to use, in the list.
Alternatively you click on the Preset once and then click the Load button.

3.Click Process.

Quick Loading of Presets
A quick way to load a Preset from the Settings tab of a dialog is to press the right mouse button on the 

Preset tab and select from the menu that appears.
               Related Topics  



Creating a Preset

1.Open the Processing dialog you wish to use and set up the dialog as desired.

2.Click on the Presets tab.

3.Click on the name line and type in a name for the Preset.

4.Click the Add button.
               Related Topics  



Modifying a Preset

1.Open the Processing dialog and select and load the Preset.

2.Click the Settings tab and modify the settings.

3.Click the Preset tab.

4.Select the Preset you want to overwrite with the new settings.
If this is the same Preset as the original, you can skip this step, since that Preset is already selected.

5.Click the Update button.
               Related Topics  



Deleting a Preset

1.In the Presets tab, click on the Preset you want to delete.

2.Click the Delete button.
               Related Topics  



Batch Processing - Assembling a List of files

1.Select Batch Processing from the File menu.

2.Click on the Files tab.

3.Click the Add button.

4.In the file dialog that appears, locate and select the desired files and click Open.
Please remember that you can use [Shift] and [Control] in the file dialog to select as many files as you wish, from 
the same folder.

5.If you want to add more files, maybe from another folder, click Add again and repeat step 4.

6.If you want to remove one ore more files from the list, select it/them and click the Remove button.
Again please note that [Shift] and [Control] can be used for selecting multiple files.

7.If you wish to clear the list completely, to start over, click Remove all.

8.If you want to treat the current wave rather than a list of files, do not select any file in the list.

Making Settings for the processed files

The next step is to decide where the processed files should be stored, what they should be called etc.

1.If you want to overwrite the original files, click the "Overwrite files" radio button. If you’d rather create completely
new files, click "Create new files" instead.
If you choose the "Overwrite" options, most of the remaining options in the dialog are greyed out. The only 
setting you need to pay attention to in this "mode" is Create Backups.

2.If you want the program to create backups of any files that would otherwise be overwritten as a result of the 
procedure, activate the "Create Backups" options.
When this is activated, the program will make a copy of the file before processing. It will change the first letter in 
the extension of the copy to "~". For example "myfile.wav", will be backed up as "myfile.~av".

If you are not absolutely sure of what you are doing, we strongly recommend you to leave this option activated, to 
avoid accidentally overwriting files.

3.If you are creating new files, specify in which folder you want them, what file format they should have (Wave or 
AIFF) and if you want to add text to the beginning and/or the end of the original name.
If you for example leave the prefix field empty and type "(processed)" in the suffix field, "myfile" will become 
"myfile (processed)".

Now it is time to move on to the tasks that should be performed on the files, see Assembling a list of Tasks. In fact, 
you can perform useful Batch Processing without specifying any Tasks at all! You might for example convert files 
from one format to another and/or just change the names of a number of files.
               Related Topics  



Batch Processing - Assembling a list of Tasks

1.Click the Tasks tab in the Batch Processing dialog.

About the window and the Lists
On the left side you have a list of tasks that will be performed on the selected file(s).
On the right side you have a list of all the available processing options, as described later in this chapter. 

These are indicated as folders and as "document icons"
If a processing option uses Presets, it will be indicated by a folder. You can "open" this folder by clicking the

+ sign next to the folder. One of the options in the folders is always called "Current values". Selecting this will 
process the files with settings last used for this processing option, or with values that you specify yourself.

For Processing options which don’t use Presets, there is only one icon, of the "document" type. Adding that 
to the task list always means that the settings last made for this processing option or settings that you supply in 
this dialog, will be used.

The tasks will be performed in the order they appear in the list to the left.

Adding a Task to the end of the list

1.If the Processing option uses Presets, click on its folder "+" symbol to open it.

2.Select the desired Preset or other option (document icon) and click the Append button.

If a Preset is greyed out, this means it can not be applied to the Task list. This happens because the Preset contains 
settings that are not valid for batch processing. An example of such a situation is when "As selected" is activated in 
the Normalize dialog. This will not work since there is no selection to work on when you perform Batch Processing, 
the entire file is always processed.

Inserting a Task into the list

1.In the list of tasks to the left, select one of the Tasks by clicking on it.
The new Task will be inserted just before this task.

2.Select the desired task in the list to the right.
See above for details.

3.Click the Insert button.

Removing Tasks
To remove one task, select it in the left list and click the Remove button.
To remove all tasks (clear the Task list completely), click the Remove All button.

Activating/Deactivating Tasks

You may decide you don’t want to use one of the Tasks in an operation, but you still want the Task list to be left 
"intact" for future use. What you do then is deactivate the Task.

Click on the check box next to the Task you want to activate/deactivate.
You can also Change the order of Tasks and Edit the Processing Settings for Tasks in the list.

Applying the Processing
Once you are done with all the Settings, click "Run" in the Tasks section of the dialog.

The files get processed one by one.
               Related Topics  



Batch Processing - Changing the order of Tasks

If you have added the correct Tasks, but realize they are in the wrong order, you may change this.

1.Select a task in the list.

2.Click the Up/Down buttons.
               Related Topics  



Batch Processing - Editing settings for Tasks

If you want to adjust the settings for a certain task, proceed as follows:
Double click on the Task in the Task list, or...
Select the Task in the list and click the Edit button.

The dialog for that processing option appears.
Adjust the settings and click OK.

               Related Topics  



Batch Processing - Using Presets
Presets can be set up for batches, just as for individual processors. See Applying a Preset.
               Related Topics  



Swap Channels

You may move the material in the left channel to the right channel, and vice versa:

1.Make a selection across both channels.
Only the material in the selected section will be swapped.

2.Select Swap Channels from the Edit menu.



Invert Phase

This turns the signal "upside down", which is the same as inverting the phase by 180 degrees. No settings are 
needed for the operation.

1.Make a selection.
Only the material in the selected section will be affected.

2.Select Invert Phase from the Level menu.

There is no audible change when you invert the phase of a mono signal. However, if one channel in a stereo pair is 
out of phase with the other, this will lead to artifacts such as a drop in the bass register and a "blurred" stereo 
image.

The most common use for this function is therefore to fix a stereo recording where one of the channels accidentally 
has been recorded out of phase with the other.

This function can also sometimes be used to create smoother transitions when splicing two waves together.



Eliminate DC Offset

This function removes a problem that most often appears due to mismatches between various recording 
equipment. No settings are needed.

Since this problem ususally occurs already when recording, it normally affects the entire file. Therefore, it is 
recommended that this function is applied to as large selections as possible, preferably the entire file.

About DC Offsets

A DC offset is when there is to large a DC (direct current) component in the signal. If the DC offset is really bad, it 
can be visible as the signal not being visually centered around the "zero level axis". However, the DC offset can be 
significant without actually being seen.

A DC offset is problematic for two reasons:
It affects where the zero crossings appear, which in turn affects the smoothness of splices between audio 

files.
Certain processing options do not give optimal results when performed on files with a DC offset.

Checking for and removing DC Offset

1.Make a selection.

2.Select Elimintate DC Offset.
A dialog appears stating the amount of DC Offset and asking you whether you want to remove it.

3.Click OK.
If other recordings have been made with the same equipment they might have the same problem.



Reverse

This turns the selection backwards.



Frequency Graph - Displaying the Graph

1.Select the part of the file you want to analyze.
If you select a stereo recording, a mix of the two channels will be analyzed.

The length of the selection affects the accuracy of the analysis. For short selections the result will be very detailed. 
For longer selections (over a minute or so) it will not give equally detailed results, since the harmonic content might
vary "between the measure points", which is then not shown in the display. You might for example make a separate 
analysis of the attack (beginning) of a sound, since the most drastic variations usually occur there.

2.Select Frequency Graph from the Options menu and click on the Frequency tab.
Actually, adjusting these settings is not required, but it is the only settings that can not be redone when the graph
is already open.

3.If you only want to see a plot for a part of the frequency range, adjust the "From" and "To" values.
The range must always span at least three octaves.

4.Decide if you want the frequency axis in the graph to be Linear or Logarithmic.
Logarithmic is often the most natural choice since each octave (doubling of the frequency) is then represented by 
an equal distance on the frequency axis. In fact this is a special WaveLab feature not commonly available in other
programs.

For more details on the dialog, see the context sensitive help.

5.Select Frequency Graph from the View menu.
The wave gets analyzed and the graph opens, in an new window.

The frequency graph shows you how the different frequency components vary over time. A high "mountain" means 
that this frequency is very prominent at that particular time.
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Frequency Graph - Adjusting the Graph

There are a number of settings you can make that affect the way the graph is displayed.

1.Select Frequency Graph from the Options menu, or click directly on the Graph.

2.Click on the Style tab.

3.Decide if you want the graph to be in color, gray scale or black and white.

4.Decide if you want to use a change in color to represent the amplitude (the height of each mountain determines 
its color) or if you want it to represent frequency (the frequency spectrum is drawn in colors ranging from red to 
purple.

5.Decide for a background color (black or white).

6.To view the effect of your changes, click Redraw.

7.Click the Perspective tab.

8.Decide from which point of view you want to watch the graph.
The drawing indicates the direction of the time and frequency axis from each point of view.

9.Decide if you want a linear or exponential amplitude display.
The Wave window’s level rulers use a linear display, so this is a natural choice to start with.

10. Again, if you so desire, click Redraw.

For more details on the dialog, see the context sensitive help.
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Projects - Creating Groups

1.To create a new Group, select the Group symbol you want the new Group to appear in.

2.Click with the right mouse button in the window.

3.From the menu that appears, select Create Group.

4.Fill in the name and click OK.
               Related Topics  



Projects - Renaming Groups

1.To rename a Group, select it.

2.Click with the right mouse button in the window.

3.From the menu that appears, select Rename.

4.Type in the name, just as in the Windows 95 Explorer and hit [Return]
               Related Topics  



Projects - Removing Groups

To delete a Groupand remove all files within it from the Project, proceed as follows:

1.Select the Group.

2.Click with the right mouse button in the window.

3.From the menu that appears, select Remove.

4.Click OK in the dialog that appears.

This only removes the items from the Project. It does not delete anything from your disks!
               Related Topics  



Projects - Adding Files

Using a dialog

To add one ore more files to a Group, proceed as follows:

1.Click on the Group you want to add the file(s) to.

2.Press the right mouse button and select Add from the menu that appears.

3.Select all the files you want to open.
You can select as many files you wish from the same folder, using [Control] and [Shift].

4.Click Open.
A file can only be added to one Group at a time.

From a Database 

You can drag and drop files from a Database to a Project, see Dragging to Another Database or Project.



Projects - Renaming Files

1.Click on the File.

2.Press the right mouse button and select Rename from the menu that appears.

3.Type in the name, just as in the Windows 95 Explorer and hit [Return].

This means the file on disk is actually renamed, just as if you had changed the name in for example the Windows 95
Explorer application.
               Related Topics  



Projects - Removing Files

To remove a file from a Group (without actually deleting it from disk) proceed as follows:

1.Click on the File.

2.Press the right mouse button and select Remove from the menu that appears.

3.Click OK in the dialog that appears.

This removes the file from the Project but does not delete anything from your disks!
               Related Topics  



Projects - Moving Files between Groups
To move a file from one Group to another, first Remove it from one Group then Add it to another.

               Related Topics  



Projects - Playing Files
To play a file, select it and press [Enter] or click Play on the Transport.

               Related Topics  



Projects - Opening Files
To open a file for editing, double click on it or click on it with the right mouse button and select Open from 

the menu that appears.
               Related Topics  



Welcome to WaveLab On-line Help!

If you get this card, in any other way than from the Topics window, you have most likely tried to get help on a topic 
for which there is no direct link.

To get general Help on WaveLab, click    on the Contents button in this window and:
Click the Contents tab to see the "Table Of Contents", or...
Click the Index tab to search for a keyword, or...
Click the Find tab to search for any word.

To get Help in a dialog, open the dialog and:
Click the question mark icon on the title bar and click on the item you need help on, or...
Click with the right mouse button on the item you need help on, and then click the "What's This?" pop-up.

This last option does not work with value fields or spin controls, since they bring up a fader or pop-up for 
adjusting the value.



General problems

Can't create a temporary file
Please check again which drive is specified for your temporary files (in the Preferences dialog). You can not

use a CD-ROM disk or a write protected drive for your temporary files.
Is the drive full? Please select a drive with as much free space as possible.

A drive/partition can't be found
Is this volume a removable drive, a CD-ROM or a floppy? In that case, is the correct disk really in the drive?
Have you renamed the Volume since you last used the program?

The program asks for the original CD-ROM
This is not a bug, it is part of the copy protection scheme. See the Installation chapter in the printed 

manual for details.

A file can't be deleted or renaned
Is the volume that the file is on, write protected? Then turn the write protection off.
Is the file on a CD-ROM? Files can not be deleted from CD-ROMs.

The program opens/doesn't open with the same files each time
This is not a bug, it's a feature! You can decide if you want the program to boot up as you last left it or not. 

This is done by activating/deactivating "Save window layout on exit" in the Preferences dialog. See Preferences 
Topics.

My snapshots are gone!
Snapshots are not saved with each audio file. There are two ways to make sure your snapshots "stay" from

session to session:
Use Save Window layout on exit (describe above) to restore all settings just as you left them.
Make the file part of a Project and open it from there. Snapshots are saved with the opened windows of a 

Project.

The cursor flickers
Under Windows 95, color cursors have a tendency to flicker a bit. This is not related to WaveLab in any 

way. If this is a problem, deactivate "Use mouse cursors in color" in the Preferences dialog.

The display flickers too much in general 
If you have a very slow computer we suggest you deactivate "Flicker free sample redraw" in the 

Preferences dialog.

The wave cursor has the wrong color
This is not a bug. To make screen redraws as fast and smooth as possible, the wave cursor is actually 

drawn in the opposite color to the one specified. In other words, red becomes green, yellow becomes blue and so 
on. While we acknowledge that this is slightly inconvenient, we hope you appreciate it helps the program to operate
as smooth as possible.

The wave isn't styled as when I opened it last
The styling is not saved with each audio file. There are two ways to make sure your files look the same 

from session to session:
Use "Save window layout on exit"    to restore all settings just as you left them.
Make the file part of a Project and open it from there. The styling is saved for each opened window of a 

Project.

Windows becomes unstable if I eject a CD-ROM that owns some files currently played back or 
processed in WaveLab

While Windows 95 is meant to notify the running applications that a removable disk is about to be ejected, 
this does not work in practice with most current hardwares and drivers. This can be a problem if a file from the CD-
ROM is being played back or processed in WaveLab, because the file becomes suddenly out of physical reach. 
Therefore, before ejecting a CD-ROM, you should make sure that some of its files are not opened in WaveLab. 
Windows NT is far more robust about this matter, as it will display a message, unlike Windows 95.



Problems with Opening files

The file doesn't appear in the Open dialog.
Does the file have the right extension? Select "All files (*.*)" from the pop-up in the Open dialog and check 

again.
Is the drive the file is on currently accessible? If you use removable hard disks or CD-ROMs, make sure the 

right disk is in the drive.

Can't open a file
Is the file really an AIFF or WAV file?
Does the file open in other programs that support audio files in these formats? If not, it is probably 

damaged.
If it is a WAV file, try opening it in the Media Player application, included with Windows. If that doesn't 

work, the file is probably damaged. Note that WaveLab checks carefully the file headers: if any mistake in the 
format is found, WaveLab does not open the file, for safety reasons. This could happen (rarely) with some files 
created by non professional softwares.

If you use Windows 95, it is important that your virtual memory settings are correct if you work with large 
audio files. In the Windows 95 Control Panel, open the System setup and click on the Virtual Memory button. Then 
click on the button "Let me specify my own memory settings". As a minimum, you should specify at least 20 
MegaBytes or if possible a value between 2 and 3 times the amount of your computer RAM memory.

Is the drive that the file is on currently accessible? If you use removable hard disks or CD-ROMs, make sure
the right disk is in the drive.

Can't open dual mono files
Open the Preferences dialog, click on the File tab and activate "Allow opening of dual mono files".



Problems with Saving files

Can't save
Is the volume you try to save on write protected? You can for example not save anything on a CD-ROM.
Is there enough space on the drive?
Is the drive the file was last saved to currently accessible? If you use removable hard disks or CD-ROMs, 

make sure the right disk is in the drive.
Are you trying to overwrite another file with the same name? Is that file then write protected? If it is, it 

can't be overwritten. Save under another name.
Are you trying to overwrite another file with the same name? Is that file open? If it is, close it and try again.
To get around all of the problems listed above, try saving to another disk/folder.



Recording problems

I can't record
Are you trying to record at a sample rate/bit resolution that your card doesn't support? Check the 

documentation for the card, to find out which formats it supports.
Is the card really installed correctly? Try using some application included with the card to see if that works. 

Also try the "Sound recorder" included with Windows.
Do you have the latest driver for your card? Is it a driver designed specifically for Windows 95? Contact 

your dealer for the latest driver.
Are your temporary files set up correctly and do you have enough free space on that drive?

My recordings are silent
Do the meters move when you record? Do you get a waveform in the window? If you do, the recording is 

not the problem, it is the playback.
Check the Mixer. Do you have the correct recording inputs activated and the levels set properly?
If you can't seem to activate the correct inputs and levels from WaveLab, try the mixer application that 

was included with your audio card. Some card drivers do not react correctly to the standard Windows commands 
transmitted by WaveLab.

Please check your cables and the devices you have connected. Is there really a proper audio signal coming
in to the card?

My recordings contain "crackles" and "pops"
This might be because you have an early Windows 95 driver for your card. As a temporary fix, activate "Fix

Win 95" in WaveLab's Record dialog. Please contact your dealer to make sure you have the latest Windows 95 
specific driver for the card.

There is too much noise in my recordings
Have you adjusted your recording levels properly?
Is the source connected to the proper input?
Have you specified 8 bits as your bit resolution? Try 16 bits instead. Moreover, be sure to have    the "Play 

as 8 bit" item unchecked in the Option menu.
Keep in mind that the microphones provided with sound cards are very low quality microphones.

The mixer can't be "created"
Have you specified your audio card in the Preferences dialog? A Mixer can't be created if "Microsoft Sound 

Mapper" is selected.
Do you have the latest and correct driver for your card? We have noted that some card drivers contain 

"bugs" that prevent a mixer from being created.



Playback problems

No playback at all
Is the card really installed correctly? Try using some application included with the card to see if that works. 

Also try the "Media Player" included with Windows. If that doesn't work, there's something wrong with the card or 
the installation.

Playback is choppy
Are you using a compressed hard drive? You should not use WaveLab on such drives because they eat up 

too much processor power! WaveLab is very CPU intensive.
To play a quality wave (eg. 16 bit Stereo 44,1 kHz file) from a CD-ROM, your CD-ROM reader must be at 

least of type "Double Speed".

A file can't be played
Is the file really in a format (sample rate, bit resolution mono/stereo) supported by your audio card? The 

format of the file is indicated on the status bar.

Playback is silent
Check the Volume setting in WaveLab (the speaker button on the Control bar). Check also the global 

volume of the sound card with the Windows application "SndVol32.exe".
Do you have an application for the audio card that allows you to adjust playback volumes? Are these 

settings correct?
Check the cables and the other audio equipment you use.



Editing problems

After editing I get click and pops
Are you making "splices" in the middle of an audio section? If you do, we recommend you to make all cuts 

at zero crossings, to avoid clicks and pops.

After equalizing the sound is distorted
It is possible to boost frequencies up to a point where clipping occurs, and the sound is distorted. If this 

happens, undo the equalizing, lower the gain of the recording (by for example 3 or 6 dB) and try again.

When I drag and drop I get a crossfade
This happens since you drop on a selection. Click once somewhere outside the selection of the destination 

wave (or press [Esc]) and try again.

After crossfading I get distortion
If both sections play at full level during the crossfade, it is possible that clipping occurs (although it is 

unlikely). If this happens, undo the crossfade, lower the gain of both sections (by for example 3 or 6 dB) and try 
again. The problem cannot happen if you check the "Invert of Fade In" or "Invert of Fade Out" options.



Database and Project problems

Where are my files in the Database?
See Database File Topics.
Do you have the Global Filter activated? Turn it off.

A new database/project can't be created
Is the volume where you try to store the file write protected? You can for example not create Databases 

and Projects on CD-ROMs.
Is the disk full?

A file can't be found opened or played
Has the name or the extension of the file been changed since you last used the Project/Database? Please 

try to open the file from the Open dialog?
Have you moved the file to another folder?
Have you renamed the Folder (in the Database)?
Is the drive that the file was on currently accessible? If you use removable hard disks or CD-ROMs, make 

sure the right disk is in the drive.

Not all files get added to database as expected
When performing a "Scan Disk" operation, the list will not display all files just registered, but only those 

from the last scanned folder. Please also check the "Maximum list size" in the Database part of the Preferences 
dialog.

A file can't be renamed or deleted
Is the volume that the file is on write protected? Then turn the write protection off.
Is the file on a CD-ROM? Files on CD-ROMs cannot be deleted or renamed.
Is the drive the file was last saved to currently accessible? If you use removable hard disks or CD-ROMs, 

make sure the right disk is in the drive.





How to Dock a "Bar"

Various tools, short-cuts and commands are gathered on "Toolbars" (strips with symbols). These can be used either 
as "palettes" (separate windows) or you can "dock" them to the window edges. The following Toolbars are available:

The Control Bar
The Transport
The Toolbox
The Snapshot Toolbar

There are two ways to dock a Toolbar:
Drag the Toolbar window (by its title bar) to any of the sides of the application window and release the 

mouse button.
The outline shows you the shape of the toolbar at the docked position.

Double click on the title bar of a Toolbar window.
It will return to its last docked position.

Please note that you can stack Toolbars and put them side by side, to create any type of layout you desire.
               Related Topics  



How to Turn a Bar into a window

There are two ways:
Drag the gray border surrounding the Toolbar’s buttons, out from the docked position, or...
Double click somewhere on the gray border.

               Related Topics  



Showing/Hiding Toolbars

There are various ways to show/hide a Toolbar:
Use the main Windows menu, or...
Press the right mouse button anywhere on a Toolbar and select from the menu that appears, or...
Use the keys [F9] to [F12].

Each of these keys "toggles" the display of one of the Toolbars.
You can of course hide a Toolbar by clicking its Close box.

               Related Topics  



Changing the appearance of Toolbars
To change the shape of a Toolbar between different variations on horizontal, square and vertical, drag the 

right or bottom edge as when resizing any other window.
To change the size of the buttons in the Toolbar, open the Preferences dialog, click the "Toolbars/Control 

Bar" tab and adjust the "Button size" setting.
               Related Topics  



Using non-modal dialogs
WaveLab uses non-modal dialogs for many of the processors, among other things. This allows you to select from 
menus and work in other windows without closing the dialog in between. Here are a few hints on what non-modal 
dialogs allow you to do:

You can play back the wave without closing the dialog.
You can Undo and Redo without closing the dialog.
You can adjust the selection before reprocessing.
There are useful hot key commands for use from non-modal dialogs (and also from all other windows in 

fact) :
[F2] Toggle focus between the dialog and the document window
[Control] - [F2] Open list of open windows
[F3] Undo
[F4] Redo
[F6] Play selection
[Shift]-[F6] Turn on Loop and play selection
[F7] Stop / Move to selection start / Move to beginning
[F8] Play (from current position)

Folding dialogs
By double clicking on the dialog's title bar, you can fold it in, so that it occupies less screen space. To unfold it, 
double click on the title bar again.



How to Check what a Bar button does

1.Select Preferences from the Options menu and click on the Toolbars/Status Bar tab.

2.Make sure "Show Tips" is activated.

3.Close the Preferences dialog.

4.Move the pointer over an item on the Toolbar and wait a short moment.
A text showing the name of the button appears.

               Related Topics  



How to Adjust pane sizes

1.Position the mouse somewhere over the divider between the two panes.

2.Drag the divider to adjust the pane size.
               Related Topics  



How to Hide Panes

In some windows, a pane can be hidden altogether.
To hide a pane, drag the border between the two panes all the way up or double click anywhere on it.

Hiding/showing the Overview pane in the Wave window can also be accomplished by pressing [O] on the computer 
keyboard or by double clicking on the divider.
               Related Topics  



How to Reveal Panes
To reveal a hidden pane, drag the miniature border symbol (above the vertical scroll bar) down or double 

click on it.

Hiding/showing the Overview pane in the Wave window can also be accomplished by pressing [O] on the computer 
keyboard.
               Related Topics  



How to Use Speed menus

Most displays have speed menus associated with them.
To bring up a speed menu, click with the right mouse button in the desired area.

In the Wave windows for example there is one speed menu for the level ruler, one for each of the time rulers and 
one for each of the waveform displays.

The Speed menus double up for the main menus (some items can be found both on speed and main menus) but 
some speed menus also contain unique items.

When searching for a function, don’t forget to check the speed menus in the window you are working in!



How to Maximize the Width of a window
Selecting the Maximize Width item on the View menu makes the window as big as the screen (or other 

factors) permit.



Working with multiple windows of the same data

You can edit one and the same data in more than one window. Among other things this allows you to work on 
different sections of a wave file (for example the start and end), without scrolling back and forth.

Creating a Second window using Menus

1.Make sure the desired window is the active one.
If it isn’t, click once in its title bar.

2.Select Duplicate View from the View menu.

Creating a Second window by dragging

1.Make sure "Create windows using mouse" is activated in the Display part of the Preferences dialog.

2.In some empty free area of the WaveLab application window, drag to make up a box.
This must be of a certain minimum size or bigger. If you don’t get any new window, try again with a bigger box.

Working with two windows

When you have two windows open that are actually views to exactly the same data, any change you make in one 
window is immediately apparent in the other.



How to Close one window

You can close one document window by: 
Clicking its close button.
Selecting Close from the File menu.
Pressing [Control]-[W].

There’s a slight difference between these: If one wave is being edited in several windows (see Working with 
multiple windows of the same data), Close on the File menu and [Control]-[W] closes all those windows at the 
same time.

If the document window(s) contain unsaved changes, you will be asked whether you want to save those changes 
before closing.
               Related Topics  



How to Close all windows
You can close all Wave Windows, or all Windows (Waves, Projects and Databases) by selecting the 

corresponding option from the Window menu.

If the document window(s) contain unsaved changes, you will be asked whether you want to save those changes 
before closing.
               Related Topics  



How to Minimize one window

WaveLab windows are minimized like any other, by clicking the minimize icon on the title bar. See your Windows 
documentation for details.
               Related Topics  



How to Minimize all windows
You can minimize all Wave Windows, or all Windows (Waves, Projects and Databases) by selecting the 

corresponding option from the Window menu.
               Related Topics  





AIFF is an audio file format defined by Apple Computers. The files can be stereo or mono, any sample rate and any 
bit resolution.



The bit resolution is the number of bits used to store each sample word when recording audio (sampling). The 
normal values are 8 or 16 bits. 16 bit files have less inherent noise than 8 bit files, but occupy twice the disk space.



A Category is a WaveLab database term. By organising your audio files into categories you can very easily find a 
number of files with similar properties, in the Database.



The clipboard is the "invisible "storage area used for any material you Cut or Copy. When you Paste, you insert the 
material from the clipboard.



Decibels (dB) is an audio level measuring unit. It is logarithmic, which means that when you double the absolute 
sound level, the increase in decibels is said to be 6 dB.



Dual mono is a special WaveLab feature. Some other systems handle stereo recordings as two mono files. WaveLab 
allows you to open two such files as a "dual mono pair" and edit and process them as if they were one stereo 
recording.



Groups are used in WaveLab Projects. By organising your files into Groups you can easily collect and maintain all 
the files needed for a project.



This is a WaveLab term. Keywords are used to categorize files so that you can search for certain "qualities" ("hard", 
"long" etc) in database Find operations.



Markers are predefined positions in the wave file. Markers can be given names and are used in various operations, 
such as selecting, drag and drop etc.



"Meter" in this context is a position format based on tempo. Meter positions are divided into bars, beats (quarter 
notes) and ticks (subdivisions of quarter notes).



Non-modal dialogs are dialog boxes which can be "left up on screen" even though you work in another window.



The waveform window is divided into a main view and an overview. The main view is the lower half and it is here all 
the editing operations are performed. In fact, the overview can be hidden and the wave window then only has one 
view, the main view.



The waveform window is divided into a main view and an overview. The overview is the upper half and is mainly 
used for navigating. The overview can be hidden completely.



Some windows (wave windows and databases) are divided into different sections, called panes. Panes are separated
by "bars" called dividers.



Dividers are the "bars" used to separate window panes from each other.



The range indicator is a "barber pole striped" line in the waveform overview. It shows you which part of the file is 
currently visible in the main view.



The sample rate is the number of samples collected per second when recording (sampling). The higher the number, 
the greater the frequency range that can be captured. CDs, for example, are recorded at a sample rate of 44.1kHz 
(44100 samples per second) which allows them to record frequencies up to and even slightly above 20kHz.



In this context, samples is a format for time rulers where the "raw" number of samples is displayed. How many 
samples there are to a second depends on the sample rate of the file. If the sample rate is for example 44.1 kHz, 
there are 44100 samples per second.



A zero crossing is a position where the waveform crosses the centre line in the waveform display (zero level). Zero 
crossings are used mainly to create splices and other edits with a minimal risk of "glitches" (pops and clicks) at the 
join.



Time code is a format used in film and video. It is used to define positions and is divided into hours, minutes, 
seconds and frames. How many frames there are to a second depends on the frame rate. The frame rate varies 
with the media and country. For example, 25 fps (frames per second) is used for video in Europe.



"WAV" is a file format commonly used for audio files on the PC platform. WAV files can be in mono or stereo, have a 
bit resolution of 8 or 16 bits and practically any sample rate.





Contextual help
To get help on any main or pop-up menu item, just select it, and with the menu still up, press [F1].
To get selective help in dialogs, click on the [?] button at the top right corner of the dialog, then click on 

the desired control in the dialog.
To get some general help about the active window or dialog, press F1.



Language
You can choose the language to use in WaveLab (English, German or French). This is set in the 
Preference dialog. For the change to take effect, you have to restart the program.



Virtual Memory
If you use Windows 95, it is important that your virtual memory settings are correct if you work with 
large audio files. In the Windows 95 Control Panel, open the System setup and click on the Virtual 
Memory button. Then click on the button "Let me specify my own memory settings". As a minimum, you 
should specify at least 20 MegaBytes or if possible a value between 2 and 3 times the amount of your 
computer RAM memory.



Troubleshooting
If you meet any problem while using WaveLab, think of looking at the "Troubleshooting" section in this 
online manual.



Session-8 compatible files
If you are a session-8 user, it is recommended to activate the option "Save session-8 compatible WAV 
files" in the Preference dialog. This will increase the size of each file by approximately 4000 byte. The 
files are still compatible with other programs that read Wave files.



AudioAccess databases
WaveLab includes a proprietary database concept called AudioAccess. This allows you to create and 
maintain databases of audio files. The files can be located regardless of which type of media they are 
stored on: hard disks, removable disks, CD-ROMs and even floppies. AudioAccess databases allow you to
organise your files into categories for fast retrieval. You can also search any media for files, based on 
various criteria.



Projects
A Project allows you to collect files that naturally belong together, for example all files used in a song, all
files used for one commercial, etc. Furthermore, Projects allow you to organise those files into groups. 
Projects also remember window settings.



Multitasking
WaveLab uses true multitasking: you are able to select, cut, copy, paste, process, load, save, etc., while 
the program is playing, even in Loop mode.



Undo/Redo
WaveLab has unlimited and instantaneous Undo and Redo, even while playing.



Extended Stereo support
Besides supporting mono and stereo files, WaveLab has a third option, called dual mono. The purpose of 
this is to support some computer based recording systems which record stereo into two separate mono 
files. With WaveLab, you can open two mono files and edit them just as if they were a single stereo file.



Multi view concept
You can edit the same data in more than one window. Among other things, this allows you to work on 
different sections of a wave file without scrolling back and forth, and with different zoom settings if 
desired. You can create a new view in two ways (assuming a wave window is already open):

In some empty free area of the WaveLab application window, drag to make up a box (not too small) and 
release the mouse.

Select Duplicate View from the View menu.



Folding/Unfolding dialogs
You can "fold in" and "unfold" dialog boxes (like for example the Record, Markers and Normalize 
windows.), by double clicking on the title bar. Useful to save screen space!



Quick window switching
By pressing [F2] repeatedly you switch between the last two active windows (two wave windows, or a 
wave window and a non-modal dialog).



Toolbars
A Toolbar can be used as a floating window (a palette) or it can be docked to any side of the application 
window. Just drag the Toolbar to and from the window side, or double click on it (but not on a button).



Moving Toolbars
To prevent a Toolbar from being docked to the application window, when dragging it, hold down [Control].



Changing the appearance of a Toolbar
To change the shape of a palette Toolbar, between different variations on horizontal, square and vertical, 

drag the right or bottom edge as when resizing a regular window.
To change the size of the buttons in the Toolbars, open the Preferences dialog, click the "Toolbars/Control 

Bar" tab and adjust the "Button size" setting.



Speed menus
When searching for a function, don't forget to check the speed menus in the different sections of the 
window you are working in. Right click with mouse to bring up the speed menu.
There is a speed menu for the Wave main view, the Wave overview, the Wave time rulers, the Wave level
ruler, the marker list, the Database catagories, the Database folders, the Database file list, the Project 
groups, the Toolbars, etc.



Spin Controls
Many WaveLab dialogs use spin controls. As an alternative to the regular ways of changing values 
(clicking on the two arrows pointing up/down), try the following:

Holding down [Control] makes the value change in larger steps.
Holding down [Control]+[Shift] changes the value to its minimum/ maximum.
The last adjusted control can be adjusted using the up/down arrow keys on the computer keyboard.
Use Sliders and pop-ups. Many times, the most convenient way to change a value is using WaveLab's 

proprietary sliders and pop-ups: just click with the right mouse button on the spin control. A pop-up menu or one or 
more sliders appears.



Pop-up sliders
When clicking with the right mouse button on a spin control, one or more sliders appear. You can of 
course use the mouse to adjust the sliders, but you can also use the keyboard:

Up/Down arrow keys changes the value by one unit.
Next/Prev page keys changes the value by several units.
Home/End sets the slider to its minimum/maximum.



Non-modal dialogs
To speed up your work, many of the dialog boxes in WaveLab are "non-modal". This means that the 
window behind the dialog can be operated even though the dialog box is up on screen.



Special keyboard shortcuts
Several special key short-cuts for the most crucial commands are available even when a dialog is open:

[F3] Undo
[F4] Redo
[F6] Play Selection
[Shift] + [F6] Activate loop mode and Play Selection
[F7] Stop
[F8] Play



Opening multiple files
You can open a number of files at the same time (Audio files and Database files). In the Open dialog, 
select as many files as you wish. This is done using [Shift] and [Control]. You can also use drag-and-drop 
from the Explorer onto the WaveLab program icon.



Opening Dual Mono files
If you have two mono files which are actually the left and right channels of a stereo recording (some 
systems handle stereo this way), you can open these as if they were a stereo file. Simply select the two 
mono files (and only those!) in the Open dialog. You can also use drag-and-drop the two files from the 
Explorer. The dual mono function can be deactivated in the Preferences dialog.



Finding the cursor
If you click on the cursor position field on the Status Bar, the view is scrolled so that the wave cursor 
becomes visible.



Cursor position
If you want to move the Wave cursor position without deselecting (if you have a selection), just point and
drag the mouse on the time ruler. This even works while playing.



Accurate positioning
To facilitate selecting and positioning the wave cursor and markers, activate Magnetize bounds on the 
Options menu. Now, the cursor, markers and the selection will snap to the following positions:

the wave cursor
the markers
the selection edges
the start and end of the audio file
the timer ruler’s origin, if different than 0



Level selections
When you have a selection "in time", you can hold down [Shift] and point and drag to also change the 
height of the selection (called a level selection). The level value is displayed on the status bar. This 
feature is used in the Normalize and Dynamics dialogs.



Noise level
To check the noise level in a recording, proceed as follows:
1. Make a selection in a silent part of the recording (that is, a place where there's only noise).
2. Select "Extend to peaks" from the Edit / Select menu. The noise level will be displayed in the status 
bar.
This procedure can be used in combination with the Dynamics dialog to create a noise gate (as a start, 
use the function "Add point at level selection" in the Dynamics dialog).



Copying using drag-and-drop
You can copy audio from one window to another or to a different position in the same window, by 
dragging. First, select the audio to copy, then simply drag-and-drop it. If you hold down [Alt] or [Shift], 
the audio is moved rather than copied.



Mixing samples
To mix two recordings, copy one of them onto the clipboard and use the "Mix" command in the menu: 
Edit/Paste special.



WaveLab Clipboard
To see the contents of the WaveLab Clipboard (not the main Windows clipboard), select Clipboard from 
the Edit menu and Show from the sub-menu that appears. The Clipboard is a Wave window like any other
(but it is always in stereo) and any type of editing can be applied to it except those involving Cut, Copy 
or Paste. You can even Undo and Redo operations on the Clipboard.



Dragging to create a new mono or stereo wave
To turn a section of a wave into a new document, make a selection and drag it out of the window and onto 

an empty section of the WaveLab application window.
To convert a mono selection to stereo and vice versa, hold down [Control] while dragging. A "Mono to 

Stereo" conversion is much faster than a "Stereo to Mono" conversion as no mixing is involved. When a "Stereo to 
Mono" conversion is performed, WaveLab takes care of avoiding any clipping that would result from mixing the two 
channels.



Batch Processing
Batch Processing allows you to apply one or several types of processing to one or several files at a time, 
in one go. The Batch Processing dialog is opened from the File menu.



Time Stretch
Time stretch is an operation that allows you to change the length of a recording without affecting its 
pitch. This function is most often used to make a section of audio fit in with some other material. 
WaveLab provides a fast and high quality time stretch processor which can be found on the Process 
menu. WaveLab also provides an useful Tempo/SMPTE/Bars/Time calculator to facilitate length 
conversions.



Pitch Correction
Pitch Correction is an operation which allows you to change the pitch of a sound, with or without 
affecting its length. WaveLab provides a fast and high quality pitch processor which can be found on the 
Process menu.



Frequency Analysis
If you want to view a section of a wave file in the frequency domain rather than in the time domain, 
select it and select "Do Frequency Analysis" from the View menu.



Window Layout
If you want to prevent the window layout from being saved/restored, hold down [Control] when 
quitting/launching WaveLab. The same procedure applies to closing/opening Project files.



Window Styles
You are able to define and save various Styles for how to display the wave files. Check style on the 
Options menu. In a style you can have different settings for the overview and main view. For stereo 
waves you can even make separate settings for each channel!



Copying layouts between windows
You can copy layouts between windows. A layout includes cursor position, zoom factor, scroll settings 
and selection points. Proceed as follows:
1. Press [Alt]+[Control]-[C]. This copies the layout to an invisible "clipboard".
2. Make the window where you want to apply the layout, active.
3. Press [Alt]+[Control]-[V].



Playing waves from a Database or a Project
To play a wave from a Database or Project, select it and press [Enter] or click Play on the Transport. The 
playback starts almost instantaneously, whatever the file size and the file format, and even if the file is 
on a CD-ROM. No window opens, hence no computer power is lost with graphics.
You can use the keyboard arrow keys to move to another file in the list and play it at once (you don’t 
need to stop the previous wave; this is done automatically).



Opening a Database or Project
The control bar has an icon that corresponds to "New" and another to "Open". By default, these 
create/open wave files. But, by holding down [Control] and clicking on these icons, you can also create or
open a Project or a Database.



Batch Processing on the current wave
If you put no file in the file list of the Batch dialog, the process will be applied to the current wave (the 
wave in the top window). The whole wave is processed (any selection is ignored). Undo/Redo of the 
whole process can be performed in just one step.



Quick Zooming
To zoom out to quickly get an overview of a recording, simply press [J]. Other useful zooming shortcuts 
you can try out are [G], [H], [K], with or without [Shift], [Control] and [Shift]+[Control]. Moreover, [K] 
zooms the selection.



Selecting while playing
While a wave is playing, press and hold [+] on the numeric keypad to set the start of the selection. Release

the key to set the end of the selection.
Alternatively you can press [Shift]-[1] (on the numeric key pad) to set the selection start and [Shift]-[2] to 

set the end.



Getting an optimized vertical zoom
You can quickly adjust the vertical zoom according to the audio peaks by double clicking on the level 
ruler.



Default Database categories
The Category hierarchy that appears in new Databases can be changed. Please refer to the manual for 
detailed instructions.



Creating a new empty wave
A quick way of creating a new empty wave is to hold down [Control] and drag to make up a box in some 
empty free area of the WaveLab application. This box must be of a certain minimum size or bigger. The 
new window "inherits" its attributes from the last active window or from the "New Wave" dialog if no 
Window was displayed.



Converting 16 bit waves to 8 bit
WaveLab provides a function for converting between various wave file formats (Save Special on the File 
menu). But you can also create custom conversion procedures by using the batch Processor, for example
to convert 16 bit waves to 8 bit format.
Before any 16 to 8 bit conversion, we advise you to compress the recordings using the Dynamics 
processor, in order to minimize the perceived noise level. To do this, apply a slight compression followed 
by normalization. If your recording has many completely silent sections, consider applying    a noise gate 
processor.



Window List
To get a list of all open windows, double click in a "free space" in the application window or press 
[Control] + [F2].



Quick Preset selection
To quickly select a Preset in a dialog with tabs, click on the "Preset" tab with the right mouse button and 
select from the pop-up that appears.



Multiple views of a frequency analysis
When a frequency graph is being displayed, you can create a new view of it by pointing at some "free 
space" in the application window and dragging to make up a box. You can then change the parameters 
of this new view, for example. to change the point of view.



Switching playback between windows
To instantly switch playback between two windows, proceed as follows: Activate playback in one window 
(possibly in a loop), then click in the time ruler of the other window. Using this technique you can switch 
playback back and forth between the two windows, for example to compare them.
If you want to click in the other window's time ruler without playing it back, hold down [Control] while 
clicking.



Playback of an individual channel
With the Play tool, you have the possibility to play only the left or the right channel of a stereo file. Just 
click on the desired channel, and at the desired location.



Dropping markers
Use the [Insert] key to drop markers at playback time.



Centering the Wave display vertically
If you have used the vertical scroll bars, you can quickly centre the display vertically by double clicking 
on the level ruler while holding down [Control].



Absolute scrolling
Given a Wave window with the overview displayed, you can scroll the main view to any desired point by 
just clicking at the desired offset in the overview.



Adjusting a short loop
When you edit the edges of a (short) loop while playing, you can free the playback buffers instantly by 
pressing F5. The effect is that the new selection limits are taken in account immediatly, else the 
playback buffers need to get empty, which can take 1 or more seconds. However, pressing F5 can 
produce a small click, because of the quick transition.



Database: file list
The number of files that you can display simultaneoulsy in the Database file list can be set in the 
Preference dialog. After a search operation, and if it happens that the list can’t show all the files, then 
the Status Bar will indicate this by displaying the number of files in red.



Pop-up sliders appearance
Popup-sliders (displayed when you click with the right mouse button on a spin control in a dialog) can 
appear horizontally or vertically (the option is set in the Preference dialog, in the Editing page).



Selecting at zero crossings
If you cut out a portion of a wave and paste it in somewhere else, chances are there will be a 
discontinuity where the two waves are joined. This discontinuity will result in a transient in the wave 
when it is played back, which is perceived as a "click" or "bump" in the sound. To avoid this you need to 
make the splice at a zero crossing. WaveLab can automatically search for zero crossings, and extend the 
selection "outwards" (make it bigger at both ends) so that it begins and ends at a zero crossing.
The option is activated in the Options menu.
WaveLab also search for zero crossings when positionning a marker.



Mouse color cursors
Mouse cursors used in edit and drag-and-drop operations can be in color. This option can be set in the 
Preference dialog, in the Editing page.



Opening the marker window
To open the marker window, double-click one the time ruler.



Recording mixer
To be able to use the mixer in the Record dialog, you have to specifiy your audio card in the Preferences 
dialog. A mixer can't be created if "Microsoft Sound Mapper" is selected.



Hiding/showing a wave overview
You can drag the divider to hide/show the Overview pane in the Wave window. But, you can also double-
click on the separator or press [O] on the computer keyboard, to accomplish the same thing.



Hiding/Showing Toolbars
An alternative way to show/hide toolbars is to right click on them.



Frequency analysis options
If a frequency analysis window is active, you can open the dedicated option dialog by clicking anywhere 
in the window with the right mouse button.



Recording under Windows 95
Certain audio card drivers for Windows 95 are not yet optimized and can produce clicks when recording. 
If you experience such a problem, you can activate the option "Fix Win 95" in WaveLab's Record dialog.



Pasting beyond the end of a Wave
WaveLab allows you to paste data beyond the end of the Wave. You can use drag-and-drop or you can 
first position the cursor and then call the Paste command. Silence will be automatically added between 
the end of the file and the pasted data.



Positionning the Wave cursor
When you call the command to position the cursor at the end of the Wave or at the end of the selection, 
the cursor is moved exactly just behind the last sample (that is, at the correct position to perform an 
insertion just behind the selection or behind the end of the Wave).



Database : opening multiple Wave files
You can select several wave files in a Database (just as you would do in the Windows 95 Explorer). You 
can then drag-and-drop those files out of the Database window to open them all at once. An alternate 
way is to select the Open command from the speed menu. In that last case, press the right mouse 
button anywhere in the list except on a file name (to prevent deselecting items).
You can use the same approach to change the properties (keywords, comments) of several files of a 
Database in just one operation.



Drag-and-drop between a Database and a Project
You can use drag-and-drop to copy one or more files from a Database to a Project group.



Toolbar commands and Drag-and-drop
To perform a Cut/Copy/Delete/Silence/Play operation, you can click on the toolbar buttons, but you can 
also drag-and-drop the Wave selection over the corresponding toolbar buttons.



Opening files from the Explorer
You can open one or more files from the Explorer by using Drag-and-drop onto the WaveLab application 
window. You can also open a single file by double-clicking on it. This works with audio files, Database files
and Project files (extensions: WAV, AIF, DBA, PRJ).



Selecting between markers
To select all audio between two adjacent markers, double click between them.
To select all audio between any two markers, double click just to the right of the leftmost one, hold down 

[Shift] and double click just to the left of the rightmost one.
To select the whole wave while avoiding to select between markers, hold down [Alternate] while double 

clicking.



Selecting the Play tool momentarily
To quickly select the Play tool, you can hold down the Space Bar while the mouse cursor is over the Wave
window.



Selecting the magnifying glass tool momentarily
To quickly select the magnifying glass tool, you can hold down [Control] while the mouse cursor is over 
the Wave window.



Selecting samples in the Wave overview
The default tool for the Wave overview is the magnifying glass tool, but you can also select samples if 
you hold down [Control].



Database: default layout
Each Database remembers automatically its layout when it is closed (that is, size, position, split bar 
positions, column widths). If you want to restore the default layout, just hold [Control] when you open 
the Database.



Changing the time ruler origin
When selecting the command to change the time ruler’s origin (from the time ruler’s speed menu), only 
the corresponding view is concerned (main view or overview). However, by holding [Shift] when 
selecting the command, the origin is changed in both the main view and the overview.



Record Mixer: stereo sliders
By default, stereo sliders in the Record Mixer are "ganged" (if you adjust one, they both move) but you 
can adjust them separately by holding down [Control].



Stopping a process
Not only can you stop a Wave process by pressing [Escape] or by clicking on the STOP button that 
appears on the Status Bar while the process occurs, but you can also stop a Save operation safely. Even 
if you overwrite a file, stopping the Save operation will restore the overwritten file perfectly.



Deleting a marker
To delete a marker, drag it out of the time ruler.



Optimizing display speed
Unless you have specific needs, we recommend you to use Windows in 256 color mode. As a matter of 
fact, many graphic drivers are optimized for this mode and the difference of speed can be important.






